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About This Guide

This guide describes how to install, configure, and customize Micro Focus iPrint Appliance on your
network.

¢ Chapter 1, “iPrint Overview,” on page 11

+ Chapter 2, “What's New in iPrint Appliance,” on page 17

+ Chapter 3, “Planning Your Print Environment,” on page 21

¢ Chapter 4, “Deploying iPrint Appliance,” on page 27

+ Chapter 5, “Creating New Appliance,” on page 35

+ Chapter 6, “Migrate Existing iPrint Appliance,” on page 59

+ Chapter 7, “Document Rendering,” on page 63

+ Chapter 8, “Managing iPrint Appliance,” on page 73

+ Chapter 9, “Managing Print System,” on page 89

+ Chapter 10, “Installing and Setting Up iPrint on Client Workstations,” on page 155

+ Chapter 11, “Mobile Device Management (MDM),” on page 181

+ Chapter 12, “Troubleshooting iPrint Appliance,” on page 185

+ Appendix A, “Email Service Parameters,” on page 197

+ Appendix B, “iPrint Appliance Support Matrix,” on page 199

+ Appendix C, “iPrint Commands and Utilities,” on page 207

+ Appendix D, “TIDs for iPrint,” on page 213

Audience

This guide is intended for Micro Focus iPrint Appliance administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation.

Documentation Updates

For the most recent version of the Micro Focus iPrint Appliance 2 Administration Guide, and other
documentation for this product, visit the Micro Focus iPrint Appliance 2 Documentation Web site.

For information about configuring and using the mobile app, see the Help section of the app.

About This Guide
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IPrint Overview

Organizations want to reduce the complexity of managing printers by IT and allow end users to easily
locate and install printers.

That's where Micro Focus iPrint comes in. Micro Focus iPrint offers a single, scalable solution for
managing all of your printing across multiple office locations from any device. It lets the users print
quickly, easily, and more securely.

¢ Section 1.1, “Understanding Micro Focus iPrint,” on page 11

+ Section 1.2, “Benefits of iPrint,” on page 15

+ Section 1.3, “Challenges in Print Environment,” on page 16

Understanding Micro Focus iPrint

¢ Section 1.1.1, “iPrint Components,” on page 12

Micro Focus iPrint provides secured enterprise print services for your desktops, laptops, and mobile
devices. Micro Focus’s iPrint solution integrates with your existing corporate printers, regardless of
the printing vendor or brand allowing you to deliver self-service printer provisioning to your device
users.

iPrint Overview 11



1.1.1 iPrint Components

Figure 1-1 iPrint Overview
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+ “Users” on page 13

+ “Devices” on page 13

+ “Protocols” on page 13

+ “Administration” on page 13

¢ “Accounting With iPrint” on page 14
+ ‘“ldentity Source” on page 14

+ “iPrint Appliance” on page 14

+ “Renderers” on page 14

+ “Printers” on page 14
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Users

Users can submit print jobs through iPrint from their desktops, laptops, or mobile devices to both new
and legacy printers from all the major print vendors, without worrying about print drivers. You can
either import users from an existing LDAP source or create new users on the iPrint Appliance.

Devices

iPrint supports printing from desktops, laptops, or mobile devices.
Desktops and laptops: Clients for Windows and Mac workstations.

Mobile Devices: Apps for iOS, Android, Windows, Amazon Kindle, and BlackBerry devices.

Protocols

IPP/ Email: The devices and app uses IPP (Internet Printing Protocol) or email to submit the print job.
If a direct network connection to iPrint Appliance is unavailable, the device switches to email printing,
and uses the email client configured on the device.

LDAP: LDAP is used for communication between iPrint Appliance and identity stores (eDirectory and
Active Directory).

HTTPS: HTTPS protocol is used for secure communication between iPrint Appliance and remote
renderers.

LPR/RAW/SNMP: iPrint Appliance supports printer communications using the Line Printer Remote
(LPR), RAW, or SNMP protocols.

Administration

Using Micro Focus iPrint Appliance Management Console, you can add and manage printers, check
the printer status, create printer maps, and monitor the appliance.

iPrint Configuration: Use for initial iPrint configuration and setup. You can configure items such as
mobile printing, LDAP user/group sources, renderers for enhanced document conversion, and so on.

Appliance Configuration: : Use this tool to reconfigure the system's network settings, time, SSL
certificates, and passwords. Network Settings should not be changed once iPrint Appliance
Configuration has been initiated.

iPrint Printer Configuration (iManager): iManager is a web-based tool that allows you to set up
and manage your print environment. You can create printers, printer drivers, profiles, and users.

iPrint Health Monitor: Monitors your iPrint environment. You can view status of print jobs and
manage jobs, and generate audit reports that show details of who printed and how much.

iPrint Migration Utility: You can migrate printers, drivers, driver profile, and printer configuration
details from your existing NetWare or OES environment.

iPrint Map Designer: Use this tool to create map displaying the location of printers. Users can
identify and install printers that are nearest to their location.

Ganglia: You can access various real-time monitoring statistics for all of the Ganglia-enabled
machines on your network segment.

iPrint Overview 13



14

Accounting With iPrint

Print Accounting: Micro Focus iPrint integrates with third-party print accounting solutions to provide
full support for accounting the print jobs including tracking all the print jobs and keeping a tab on the
paper consumption. The print accounting feature enables the print administrator to have a clear
understanding of who is printing what and when, and apply charge back capabilities if required.

Direct Print Accounting: A printer that is enabled for iPrint Direct sends print jobs directly to the
printer instead of sending the job to the print server first. The print job is sent to the printer in LPR or
raw 9100 format, depending on the setting in the gateway autoload command for the printer. Although
this greatly reduces server communication, the ability to audit print jobs is lost. However, if you are
running a third-party print accounting solution, Micro Focus iPrint client can integrate with the third-
party print accounting solution to provide support for accounting print jobs to direct printers.

To install and configure third-party print accounting solution, refer to their documentation.

Identity Source

It works with LDAP directories such as Active Directory and eDirectory. Micro Focus iPrint makes
secure printing easy by integrating its data store with your identity directory.

iPrint Appliance

Print and mobile server are the main components of appliance which handle all print jobs and all print

infrastructure.

Renderers

+ “Local Renderer” on page 14
+ “Remote Renderer” on page 14

Local Renderer

iPrint Appliance is bundled with an in-built document renderer (local renderer). The local renderer
converts documents to the PDF format, then converts them to the print ready format using CUPS.
The renderer supports Open Office, Microsoft Office and image formats, and also has a
multithreading feature.

Remote Renderer

iPrint Appliance ships with a remote renderer. For desktop-quality printing, it is highly recommended
that you install the remote renderer. You can download the remote renderer from the iPrint Appliance
Management Console.

The remote renderer provides high quality rendering for Microsoft Office and PDF document formats.

Printers

Users can send print jobs through iPrint to both new and legacy printers from all the major print
vendors.

Micro Focus iPrint Appliance 2 Administration Guide



1.2 Benefits of iPrint

Self-service printing: Users can print from their desktops, laptops, or mobile devices without waiting
for the helpdesk to set-up a printer.

From desktops or laptops, users can print by selecting printers on a map using a web browser.

From mobile devices, users can print to any organizational printer using an iPrint app, email, or via
AirPrint™,

WalkUp printing: Print jobs sent by the users are put on hold and can be released to a desirable
printer.

Mobile device printing: Users of iOS, Android, Windows, and Blackberry mobile devices can
download apps that allow them to print from their mobile devices directly to any of your organization's
printers.

Micro Focus iPrint provides all of the necessary document rendering and conversion.

Expand your horizons: Users can print any time, from anywhere, using almost any device. Click to
send a print job to any printer irrespective of the location of the printer.

Works with everything: iPrint provisions print services for nearly every device you have, including
desktops, laptops, smartphones, and tablets. It works whether users are printing from Mac or
Windows. It works on iOS, Android, Windows Mobile, and BlackBerry.

Simplified enterprise printing: Micro Focus iPrint connects all your organization's workstations and
mobile devices to your current printers. iPrint scales exceptionally well, reducing the server
infrastructure you need to maintain hundreds or thousands of printers and thus lowering your network
bandwidth costs.

AirPrint Integration: Makes wireless, proximity-based printing a possibility across your organization.
Allows iOS users to use their devices' AirPrint capabilities with the iPrint printer.

Samsung KNOX certified: Enhanced security for Android devices while maintaining user-friendly,
secure mobile printing in your corporate environment.

QR Code Support: Scan a QR code to quickly connect your mobile device to a specific printer.

Email print jobs to any iPrint printer: Any email-enabled device can print to any iPrint printer by
sending the print job in the body of the email or as an attachment.

Secure printing: You can secure your data before it goes to the printer, provisioning print services
based on user, group and container membership.

Works in heterogeneous environments: Saves IT time and money by significantly reducing the
management burden required for mixed fleets of Mac or Windows desktops. It works across the major
mobile platforms as well, meaning IT only has to manage a single print solution for all your
organization's endpoints.

Leverages your current directory service: Micro Focus iPrint makes secure printing easy by
integrating its data store with your identity directory. It works with lightweight directory access protocol
(LDAP) directories such as Active Directory and Micro Focus eDirectory.

Works with legacy printers: Mobilize your existing fleet of printers rather than buying new. It works
with what you have now and what you may want going forward.

iPrint Overview 15



1.3 Challenges in Print Environment

End users:

+ Printing from mobile devices (BYOD)
+ Ease of installing printers and printer drivers
+ Updating printer specific drivers

Administrators:

+ Complexity of managing printers and printer drivers
+ Auditing and accounting of print jobs

*

Health-monitoring of a printer
+ Secure printing

*

Printing in heterogeneous environments - Windows and Mac platforms

16 Micro Focus iPrint Appliance 2 Administration Guide



2 What's New in iPrint Appliance

2.1

2.1.1

This section describes enhancements and changes to Micro Focus iPrint Appliance.

Highlights

+ Section 2.1.1, “WalkUp Printing,” on page 17

+ Section 2.1.2, “iPrint Release Portal,” on page 18

+ Section 2.1.3, “Improved Installation,” on page 18

+ Section 2.1.4, “Automatic Backup of iPrint Appliance,” on page 18
+ Section 2.1.5, “Renderer,” on page 18

+ Section 2.1.6, “Usability Enhancements,” on page 18

¢ Section 2.1.7, “Improved Appliance Migration,” on page 19
¢ Section 2.1.8, “Apple® AirPrint™ Certified,” on page 19

+ Section 2.1.9, “Desktop Printing,” on page 19

¢ Section 2.1.10, “Mobile Printing,” on page 19

¢ Section 2.1.11, “Email Printing,” on page 20

WalkUp Printing

WalkUp printing allows users to put print jobs on hold and releases them to a desired printer.

WalkUp is a virtual print queue that includes group of physical printers. The jobs sent to a WalkUp
printer are put on hold by the iPrint Appliance server and can be released to a desirable printer.

Benefits:
+ Flexibility to print from any printer: Allows users to print documents to any printer. Even if a
printer is unavailable, user can select another printer and collect the printout.

+ Simplified User Printing: User no longer needs to install multiple printers. Installing a single
WalkUp printer will allow the user to release documents to multiple printers.

+ Saves Paper: Many times a user gives print and forgets to collect the documents from the
printer. WalkUp printing prevents such accidental and unwanted prints by putting the job on hold
and releasing only when the user wants it. The dormant jobs are automatically deleted. The
users can now print or cancel the hold job as per their convenience.

+ Enhanced Security: Users have to authenticate and then only the documents can be viewed or
released. This ensures confidentiality of the document is maintained and only the owner collects
the document.

For more information about creating and managing WalkUp printer, see WalkUp Printers.
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2.1.2

2.1.3

2.14

2.15

2.1.6

iIPrint Release Portal

The release portal allows users to print jobs (that are on hold) to a desired printer from devices such
as mobiles, tablets, laptops, and so on.

The release portal displays the list of jobs that are put on hold, the submission time, and the expiry
time of the job.

To launch the Release Portal in a web browser, specify the server address/username (<https://
<Appliance_IP-address or host_name>/user).

For more information, see iPrint Release Portal for Users.

Improved Installation

The experience to install the iPrint appliance is improved by providing new flow, intuitive strings, and
progress bar. For more information, see Creating New iPrint Appliance.

Automatic Backup of iPrint Appliance

Automatic backup is now triggered every midnight. However, you can also trigger a manual backup.

The backup process creates a password-protected zip file with the configuration settings of the
appliance. You can download this file and use it to perform migration.

Renderer

Renderer has been enhanced for better performance and reliability.

Local Renderer

The local renderer can now be configured with a PCL 4 driver in addition to the existing PostScript
driver.

Flexible Communication Options

In addition to secure communication, iPrint Appliance now accepts non-secure communication from
the Remote Renderer. In the Renderers's page, a new Settings icon has been added to select secure
communication. If this option is not selected, both secure and non-secure communication will be
supported.

For more information, see Secure and Non-secure Communication Support (Remote Renderer).

Usability Enhancements

+ Simplified and intuitive appliance management.

+ Introduction of visually intuitive icons

+ Page split for better segregation of appliance versus iPrint functions

+ New “Get Started” guide for quick reference

+ Improved deployment experience with informative splash screens

+ On configuring email or mobile settings, you no longer have to restart the mobile server
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2.1.7

2.1.8

2.1.9

2.1.10

Improved Appliance Migration

+ Improved experience to perform migration from 1.1 to 2.
+ From iPrint Appliance 2 onwards, you must include a secondary disk that stores the appliance
configuration details to facilitate seamless migration.

For more information, see Migrate Existing iPrint Appliance.

Apple® AirPrint™ Certified

Print from any Mac or iOS device without installing additional software.

Desktop Printing

Micro Focus iPrint connects all your organization's workstations to your current printers. It allows IT to
set up a self-service printing environment in which employees can print on demand instead of calling
IT with print-provisioning needs.

iPrint Client 6.03 for Windows

The iPrint Client is upgraded to version 6.03 and is available for Windows 10.This client is also
available for Windows 8.x, Windows 7, Windows Vista, Windows Server 2008 R2, and Windows
Server 2012 R2. For more information, see Installing the iPrint Client.

+ Direct Print Accounting Support: Supports print accounting for direct printers with third-party
print accounting solutions such as PaperCut. For more information, see Accounting With iPrint.

+ Simplified Printer Installation: Users can now install printers using the latest Google Chrome
browser and get an improves installation experience with the Firefox browser. In addition, on the
Internet Explorer browser, you no longer need to run as an administrator to install printers on the
Windows operating systems.

IPrint Client 6.02 for Mac

The iPrint Client is upgraded to version 6.02 and is available for Mac 10.11 (El Capitan). This client is
also available on Mac OS X 10.8 or later versions. The users can now install printers using the
Google Chrome browser and get an improved installation experience with the Safari and Firefox
browsers. For more information, see Installing the iPrint Client.

Mobile Printing

Users of i0S, Android, and Windows mobile devices can download the Micro Focus iPrint app from
their respective mobile stores. The iPrint app allows you to print from the mobile devices directly to
the printers in your organization. The iPrint server includes all the necessary document rendering and
conversion for printing from mobile devices.

Android Native Printing

You can now print documents by enabling the iPrint app to use Android’s native print service. The
native print support is available from Android KitKkat 4.4 and later.

What's New in iPrint Appliance 19



2.1.11  Email Printing

Users can print from any email-enabled device by sending an email to iPrint. You can set up a single
email address for the organization's printing, or one for each printer.

+ Embedded Images: Supports printing of images that are part of the email message body.

+ Whitelists: Set up whitelists and other controls to increase the security of email-based printing
to ensure only relevant print jobs are processed.
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Planning Your Print Environment

This section describes the requirements for installing iPrint Appliance.

+ Section 3.1, “Server Requirements,” on page 21

+ Section 3.2, “Ports Requirements,” on page 22

+ Section 3.3, “Remote Renderer Requirements,” on page 25
+ Section 3.4, “Mobile Requirements,” on page 26

+ Section 3.5, “Migrate Requirements,” on page 26

Server Requirements

iPrint Appliance works with any virtualization software that can run the .ov£, .vhd , or .xen file
formats.

+ Virtualization software. For support matrix, see Section B.8, “iPrint Appliance Server and Client
Support,” on page 202.
+ Directory service:
+ NetlQ eDirectory 8.8 or later
+ Active Directory configured on Windows Server 2012 R2 Standard Edition
+ Active Directory configured on Windows Server 2008 R2 Enterprise Edition
+ NTP server details:
¢ |P address or hostname
+ |P address details for iPrint Appliance, including:
¢ Static IP address
+ Network mask
+ Gateway IP address
+ Host name associated with the IP address
+ |P address of a DNS server

+ The IP address assigned to the iPrint Appliance and remote renderer must have DNS host entry
in the DNS server. Ensure that the DNS entries are in the same domain.

If you do not have a DNS server to resolve the hostnames, you can use the hosts file to resolve
the same as follows:

+ Ensure that the hosts file is updated with the iPrint Appliance and remote renderer details
(IP and hostname) in both the iPrint Appliance and the remote renderer machine. The
hosts file is located at:

iPrint Appliance: /etc/hosts
Remote renderer in the Windows machine: ¢:\Windows\System32\drivers\etc

+ If you are using a third party certificate, ensure that the hostname of the iPrint Appliance and
remote renderer are configured with the domain name against which the certificate is issued. For
example, appliance.xyz.com and remoterenderer.xyz.com.
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+ |f the iPrint Appliance and remote renderer, requires same IP address to resolve two different
host names, then during the appliance configuration, do one of the following:

+ Ensure that the /etc/hosts file of iPrint Appliance is updated with the IP address and
hostname (domain name against which the certificate is issued) of the iPrint Appliance and
remote renderer.

+ If you have a DNS server, then ensure that the PTR record entry for hostname matches the
domain name of the used certificate. Ensure to remove all the other hostnames from the
hosts file.

+ Memory: 4 GB RAM or higher is recommended.
+ Primary Hard Disk: 40 GB. This disk stores the Operating System and all the binaries.

+ Secondary Hard Disk: 40 GB. This disk stores the configuration details of the appliance. All
the WalkUp jobs are also stored on the secondary disk. Depending on the usage of the print
service, decide the space required on the secondary disk.

3.2 Ports Requirements

Figure 3-1 iPrint Appliance Ports Map
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Desktop Clients: Open the ports on your clients to communicate with iPrint Appliance, printers and
LDAP sources.
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Operating Connection Port Protocols Description
System Type
Windows
Outbound 9443 The release portal uses this port to
communicate with iPrint Appliance
Outbound 636 LDAPS (Secure) To communicate with LDAP sources
Outbound 631 IPP To communicate with the printers
9100 RAW
515 LPR
161 SNMP
524 To communicate with eDirectory using
DClient
Mac
Outbound 9443 The release portal uses this port to
communicate with iPrint Appliance
Outbound 631 IPP To communicate with the printers
9100 RAW
515 LPR

Mobile Apps: Open ports on your mobile devices to communicate with iPrint Appliance and printers.

Operating System  Connection Port Protocols Description
Type
iOS, Android, Outbound 443 HTTPS To communicate with iPrint Appliance and with
Windows, the printers
Blackberry
Outbound 631 IPP To communicate with the printers
80 TCP

Remote Renderer: Open the ports for various communications between iPrint Appliance and

printers.
Operating System  Connection Port Protocols Description
Type
Windows Inbound 8080 HTTP To allow Management Console and Mobile
server to connect with the renderer
Inbound 8443 HTTPS To allow secure communication
Outbound 9100 RAW To communicate with the printers
161 SNMP
515 LPR
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iPrint Appliance: Open the ports for various communications between iPrint Appliance and printers.

Tasks Connection Port Protocols Description
Type
Printers Outbound 9100 RAW To communicate with the printers
161 SNMP
515 LPR
80 TCP
AirPrint Inbound 631 IPP To perform AirPrint jobs
5353 mDNS/
UDP
Outbound 5353 mDNS/ To advertise iPrint printers as iOS AirPrint printers
UDP
Desktop Inbound 515 LPR To allow Desktop clients to communicate with the
Clients appliance
LDAP Import  Outbound 524 NCP To perform LDAP import and authenticate users to the
(Dclient)  configured LDAP sources
636 LDAPS
(Secure)
389 LDAP
(Non-
Secure)
Inbound 22 SSH To allow access to appliance to perform LDAP Import
636 LDAPS
(Secure)
389 LDAP
(Non-
Secure)
Management Inbound 9443 To allow access to iPrint Management Console
Inbound/ 443 HTTPS To perform iManager tasks
Outbound
80 TCP
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3.3

Tasks Connection Port Protocols Description

Type
Mail Server Outbound 143 IMAP To communicate with the Mail server.
993 IMAPS
(Secure)
110 POP3
995 POP3
25 SMTP
465 SMTP
(Secure
via SSL)
587 SMTP
(Secure
via TLS)
Ganglia Inbound 8080 To configure Ganglia
Configuration (blocked)
8081
8443
8444
8649

NOTE: For ports required by the 3rd party products, you must refer their documentation.

Remote Renderer Requirements

For desktop quality printing for Microsoft Office and PDF documents, you must install a remote
renderer. The minimum requirements are as follows:

*

*

Install the renderer on a Microsoft Windows 64-bit system

Windows 8.1 / Windows 8/ Windows 7 SP2 /Windows 2012 R2/ Windows 2008 R2 Enterprise
with a dual-core processor or higher

Microsoft Office 2013 64-bit

Microsoft Office 2013 32-bit

Microsoft Office 2010

Adobe Acrobat XI Professional (Optional)
Adobe Acrobat X Pro

Microsoft .Net Framework 4 or later

The IP address assigned to the iPrint Appliance and remote renderer must have DNS host entry
in the DNS server. Ensure that the DNS entries are in the same domain.
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If you do not have a DNS server to resolve the hostnames, you can use the hosts file to resolve
the same as follows:

+ Ensure that the hosts file is updated with the iPrint Appliance and remote renderer details
(IP and hostname) in both the iPrint Appliance and remote renderer machine. The hosts file
is located at:

iPrint Appliance: /etc/hosts
Remote renderer in the Windows machine: ¢:\Windows\System32\drivers\etc

+ If you are using a third party certificate, ensure that the hostname of the iPrint Appliance and
remote renderer are configured with the domain name against which the certificate is issued. For
example, appliance.xyz.com and remoterenderer.xyz.com.

+ [f the iPrint Appliance and remote renderer, requires same IP address to resolve two different
host names, then during the appliance configuration, do one of the following:

+ Ensure that the /etc/hosts file of iPrint Appliance is updated with the IP address and
hostname (domain name against which the certificate is issued) of the iPrint Appliance and
remote renderer.

+ If you have a DNS server, then ensure that the PTR record entry for hosthame matches the
domain name of the used certificate. Ensure to remove all the other hostnames from the
hosts file.

3.4 Mobile Requirements

For more information on the supported platforms, see Section B.2, “Mobile Operating System
Support,” on page 199.

3.5 Migrate Requirements

+ Configuration file (iprintconfig.zip) of the earlier version of appliance or secondary disk that
includes the earlier version configuration file.

For more information, see Chapter 6, “Migrate Existing iPrint Appliance,” on page 59.
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4.1

411

Deploying iPrint Appliance

*

*

Section 4.1, “Configuring Virtual Environment,” on page 27
Section 4.2, “Initial Appliance Configuration,” on page 32

Configuring Virtual Environment

You must download the iPrint Appliance and configure the virtual environment where you plan to run
the appliance.

The process of downloading the iPrint Appliance and configuring the virtual environment differs,
depending on which virtual environment you plan to use to run the iPrint Appliance.

*

*

*

*

Section 4.1.1, “WMware Configuration,” on page 27
Section 4.1.2, “Citrix Xen Configuration,” on page 28
Section 4.1.3, “Xen Configuration,” on page 29
Section 4.1.4, “Hyper-V Configuration,” on page 31

VMware Configuration

1

© 00 N O 0o b~ W

10

11

Download the iPrint software (1Print.x86 64-version.ovf.zip) to your workstation.
You can download the software from the Vibes Downloads page (http://download.novell.com).

Extract the iPrint.x86 64-version.ovf.zip file on your workstation. The iPrint-version
folder is created with the .ovf file.

NOTE: On a VMware workstation, do not extract the iPrint .x86 64-version.ovf.zip file
using the default Windows extractor. On deploying this file, you may receive an error message,
Access is Denied. To resolve this issue, extract the file using any other third-party extractor.

In the vSphere client, click File > Deploy OVF Template.

Browse to and select the .ovf file from the iPrint-version file folder.

Click Next.

Click Next again.

In the Name field, specify name for the iPrint appliance, then click Next.

Select the location to store the virtual machine files, then click Next.

Click Next to accept the disk format.

Review the deployment settings, then click Finish.

On successful deployment, ensure to add a secondary disk before starting the VM.

Add a secondary disk for the appliance. The appliance configuration details will be stored in this
location.

11a In the vSphere client, right-click the virtual machine that you just created, then click Edit
Settings.

The Virtual Machine Properties page is displayed.
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12
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1

11b On the Hardware tab, click Add.
The Add Hardware dialog box is displayed.
11c Select Hard Disk, then click Next.
11d Select Create a new virtual disk, then click Next.
11le Specify the disk space, then click Next. Recommended size is 40 GB.
11f In the Advanced Options, continue with the default selection, then click Next.
11g Review the settings, then click Finish.
Power on the appliance (virtual machine).
Continue with Initial Appliance Configuration.

Citrix Xen Configuration

Download the iPrint software (1Print.x86 64-version.ovf.zip) t0 your management
workstation.

You can download the software from the Novell Customer Center (NCC) (https://
www.novell.com/center). Or, you can download an evaluation version of the software from the
Novell Downloads page (http://download.novell.com).

Extract the iPrint.x86 64-version.ovf.zip file on your management workstation.

In the Citrix XENCenter client, right-click the server on which you will install iPrint Appliance, then
click Import.

The Import OVF/OVA Package wizard is displayed.
Import Source: Browse to iPrint.x86_64-version folder and select the . ovf file.

5 Location:

10

Click Next to continue with the default settings.

Storage: Select one or more storage repositories (SRs) where the disk images for the imported
VMs will be placed, then click Next.

Networking: To map an incoming virtual network interface to a target network, select a network
from the list in the Target Network column, then click Next.

The Network and MAC address shown in the list of the VMs are stored as part of the definition of
the original (exported) VM in the export file.

Security:

If the selected OVF/OVA package is configured with security features such as certificates or a

manifest, select Verify manifest content to verify the list of files in the package. If the packages
are digitally signed, the associated manifest is verified automatically and so the Verify manifest
content option is not available on the Security page.

Click Next.

OS Fixup Settings: Since the VMs are created on XenServer, select Don’t use Operating
System Fixup, then click Next.

Transfer VM Settings: Configure the network settings, then click Next.
10a Select a network from the list of network interfaces.

10b To configure networking settings manually, select Use these network settings and enter the
IP address, subnet mask and gateway.

We recommend you to provide the same IP address that you plan to use for iPrint VM
server. However, you can also provide a temporary IP address.
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Review all the import settings and then click Finish to begin the import process and close the
wizard.

The import progress is displayed in the status bar at the bottom of the XenCenter window and
also on the Logs tab.

Add a separate hard disk for the appliance. The appliance configuration details will be stored in
this location.

12a In the Citrix XENCenter client, select the virtual machine that you just created, and click on
the Storage tab.

The Virtual Disks page is displayed.
12b Click Add.
The Add Virtual Disk dialog box is displayed.
12c In the Name field, specify the name of the virtual disk.

12d In the Size field, specify the amount of hard disk space that you want to allocate. 40 GB is
recommended.

12e Click Add.
Power on the appliance (virtual machine).
Continue with Initial Appliance Configuration.

4.1.3 Xen Configuration

1

Log in to the host server either locally or from a remote workstation.

You can use the following command to log in to the host server from a remote workstation on
Linux:

ssh -X root@host ip address

You must use the -X in the command in order to display the GUI installation program. The steps
in this section use the GUI installation program to configure the server.

Navigate to the /var/lib/xen/images directory on the host server.
Create a new directory inside the images directory where you can download the iPrint software.

The name of this directory must be the same as the name that you plan to use for your iPrint
virtual appliance. For example, if you plan to name the iPrint appliance iprint1, the name of this
new directory must also be iprint1.

Change to the directory that you just created. For example, /var/lib/xen/images/iPrintl.

5 Download the iPrint software (iPrint .x86 64-version.xen.tar.gz)to the current directory on

the host server. For example: /var/lib/xen/images/iPrint1l

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (http://
download.novell.com/Download?buildid=9xcn1vXns5A~) on the Novell Downloads page (http://
download.novell.com).

Untar the iPrint .x86 64-version.xen.tar.gz file in the directory where you downloaded it.
You can use the following command to untar the file:
tar -Sxvzf iPrint.x86 64-version.xen.tar.gz

A ipPrint-version directory is created, which contains a . raw file that you will use to run the
virtual image. This process can take a few minutes.

From the host server, run the following command to launch the GUI configuration menu:

vm-install
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The Create a Virtual Machine wizard is displayed.

Click Forward.

Select | have a disk or disk image with an installed operating system, then click Forward.
Leave SUSE Linux Enterprise Server 11 selected, then click Forward.

Rename the virtual machine by clicking Name of Virtual Machine, then specifying a new name in
the Name field. Then click Apply. For example, iPrint1.

Configure the amount of memory and number of CPUs that Xen allocates for the iPrint
appliance.

12a On the Summary page, click Hardware, then specify the following information:

Available Memory: Displays the amount of available memory that is available on the host
server.

Initial Memory: 4 GB is the recommended minimum amount of memory.
Maximum Memory: Set this to the same value that you set for Initial Memory.
Available Processors: Displays the number of available processors on the host server.
12b Click Apply.
Configure the bootable disk image:
13a On the Summary page, click Disks.
13b Click Harddisk.
13c On the Virtual Disk page, specify the following information:
Source: Click Browse, then browse to the . raw file that you untared in Step 6.
Protocol: Select file:.
Size (GB): The default size is 40.1 GB. This cannot be changed.
Create Sparse Image File: This option is not available.
Read-Only Access: Do not select this option.
13d Click OK.

Add a separate Xen hard disk. You must add a hard disk to the virtual machine before you
choose this option. If you have not already added a hard disk, click Power Off Virtual Machine,
modify the virtual machine settings to add a hard disk, then power on the virtual machine.

14a On the Disks page, click Harddisk.
14b On the Virtual Disk page, specify the following information:

Source: This field should already contain the path to the . raw file that will be created when
the virtual machine is created. If desired, you can rename the disk in the source field from
disk0 to a hame of your choosing.

Size (GB): Specify the amount of hard disk space that you want to allocate. 40 GB is
recommended.

Click OK > Apply.

Click OK to save your changes and to create and power on the virtual machine.

IMPORTANT: Do not power on the appliance until you have created a separate Xen hard disk
for the appliance, as described in Step 14.

Continue with Initial Appliance Configuration.
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4.1.4 Hyper-V Configuration

1 Log in to the host server either locally or from a remote workstation.
You can use Windows Remote Desktop to log in to the host server from a remote workstation.

2 Create a new directory in the location where you want each virtual machine to reside (for
example, C:\Users\Public\Documents\Hyper-V\Virtual Hard Disks). In a later step, you
will download the iPrint software to this directory.

As a best practice, give this directory the same name as the name that you plan to use for your
iPrint virtual appliance. For example, if you plan to name the iPrint appliance iprint1, the name
of this new directory should also be iprinti.

3 Download the iPrint software (iPrint .x86 64-version.vhd.zip) to the directory on the host
server that you created in Step 2.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (http://
download.novell.com/Download?buildid=9xcn1vXns5A~) on the Novell Downloads page (http://
download.novell.com).

4 Extractthe iPrint.x86 64-version.vhd.zip file to the directory on the host server that you
created in Step 2.

5 Open the Hyper-V Manager.

6 In Hyper-V Manager, right-click the disk name in the Action Pane in the left-hand column of the
Hyper-V Manager window. This is the disk where you want to create the new virtual machine.
Then click New > Virtual Machine.

The New Virtual Machine Wizard is displayed.
7 Review the Before You Begin page, then click Next.
8 In the Name field, specify a name for the new virtual machine. For example, iPrint1.
9 Click Next.

10 In the Startup memory field, specify the amount of memory (in MB) to allocate to the virtual
machine. 4 GB is the recommended minimum for a iPrint.

11 Click Next.
12 On the Configure Networking page, select the networking card of your choice, then click Next.
13 Configure the bootable disk image:

13a On the Connect Virtual Hard Disk page, select Use an existing virtual hard disk, then
browse to the .vhad file that was in the downloaded . zip file that you extracted in Step 4.

13b Click Open to select the file, then click Next.
14 Click Finish.

15 Create a separate Hyper-V hard disk for the appliance. You must add a hard disk to the virtual
machine before you choose this option. If you have not already added a hard disk, click Power
Off Virtual Machine, modify the virtual machine settings to add a hard disk, then power on the
virtual machine.

NOTE: If you do not add a hard disk to the virtual machine, then iPrint Appliance is installed on
the default partition. The default partition is /sda.

15a In Hyper-V Manager, right-click the disk that you just created, then click Settings.
15b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.
15c Select Virtual hard disk, then click New.
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15d Review the Before You Begin page, then click Next.

15e On the Choose Disk Format page, select VHD, then click Next.

15f On the Choose Disk Type page, select Fixed size, then click Next.

15g On the Specify Name and Location page, specify the following information, then click Next:
Name: Specify a name for the hard disk. For example, iPrintDisk2.
Location: Specify the location where you want the hard drive to be located.

On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size for
the hard disk. 40 GB is recommended.

Click Next.

Review the summary information, then click Finish.
Click Apply > OK.

Right-click the virtual machine, then click Start.

IMPORTANT: Do not start the appliance until you have created a separate Hyper-V hard disk for
the appliance, as described in Step 15.

Right-click the virtual machine, then click Connect.
Continue with Initial Appliance Configuration.

4.2 Initial Appliance Configuration

1

After you have downloaded the iPrint appliance, configured the virtual environment, and
powered on the appliance, click the Console tab.

After the appliance starts, select your preferred keyboard layout in the Keyboard Language drop-
down, then accept the license agreement by clicking Accept.

You can change the language in the agreement from the License Language drop-down.
The Micro Focus iPrint Appliance Passwords and Time Zone page is displayed.

On the Micro Focus iPrint Appliance Passwords and Time Zone page, specify the following
network information:

Root password and confirmation: The root password for your iPrint appliance.

Vaadmin password and confirmation: The preferred user to use when logging in to the
appliance.

NTP Server: The IP address or host name of the reliable external Network Time Protocol (NTP)
server your OES server uses. For example, time.example.com.

For the best results, set up NTP in accordance with the VMware best practices guidelines.
Region: Your local region.

Time Zone: Your local time zone.

Click Next.

5 On the Micro Focus iPrint Appliance Network Settings page, specify the following information:

Hostname: The fully qualified DNS host name associated with the appliance’s IP address. For
example, myiPrint. mynetwork.example.com.

IMPORTANT: Ensure that the host name is in valid format because no validation is done in this
step. At a later stage, appliance configuration fails if the host name is invalid.
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To get the hostname, go to the command prompt and type nslookup <ipaddress>. For example,
nslookup 192.168.1.255.

IP Address: The static IP address for the appliance. For example, 172.17.2.3.

Network Mask: The network mask associated with the appliance’s IP address. For example,
255.255.255.0.

Gateway: The IP address of the gateway on the subnet where your iPrint virtual appliance is
located. For example, 172.17.2.254.

DNS Servers: The IP address of a primary DNS server for your network. For example,
172.17.1.1.

Domain Search: The domain where the iPrint Appliance is located. For example,
mynetwork.example.com.

6 Click Next.
7 Select the Hard Drive.

If you created a secondary VMware hard drive for this appliance, it is automatically detected and
sdb is displayed as the hard drive. If you have not created a secondary VMware hard drive, sda
is chosen as the default partition.

If you have added a secondary hard drive, specify the following options:
Hard Drive: Select the hard drive you are using.
Create a new partition: Select this option to create a new partition.
Filesystem type: Specify the type of file system.

8 Click Configure.

If you have not created a secondary hard disk, a warning message is displayed to power off the
VM.

8a Click Power Off Virtual Machine, then add the secondary hard disk.
8b Power on the VM and continue with the installation.

The iPrint Appliance installation process begins. A message stating, “The system is ready for
appliance configuration” is displayed. After the installation is complete, a URL and an IP address
to access the iPrint Appliance Management Console is displayed. Using a Web browser,
navigate to the Management Console URL.

The iPrint Appliance installation is now complete. You must configure iPrint Appliance before you can
start printing. Continue with Chapter 5, “Creating New Appliance,” on page 35.
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Creating New Appliance

You can configure iPrint Appliance through the iPrint Appliance Management Console.

+ Section 5.1, “Creating New iPrint Appliance,” on page 36

¢ Section 5.2, “Creating Printers,” on page 37

*

¢ Section 5.4, “Configuring Printer Drivers,” on page 46

Section 5.3, “Creating or Importing Users,” on page 46

+ Section 5.5, “Configuring Printing Through Mobile Devices,” on page 53

+ Section 5.6, “What's Next,” on page 58

You can configure new iPrint Appliance or migrate from an earlier version. To view help, click Getting

Started.

1 On a Web browser, use either the host name or the IP Address to access the Management

Console. For example, https://10.0.0.1:9443.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. To avoid the security warning prompt every time you access the iPrint Appliance
Management Console, you can add the certificate to the trusted certificates list on your browser.

2 Specify vaadmin or root as the user name.

3 Specify the password, then click Log in.

The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

. iPrint Appliance Configuration

(

Create New iPrint Appliance ;1

Migrate Existing iPrint Appliance

« Modify Settings Getting Started

5 Click Create New iPrint Appliance or Migrate Existing iPrint Appliance.

Creating New Appliance
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5.1 Creating New iPrint Appliance

Figure 5-1 Create iPrint Appliance

. Create iPrint Appliance

DNS for Print Service Q

Modify DNS Address

Authentication Realm Q

Use OES server

iManager Credentials

Usemame:
cn=admin,o=IPrintAppliance

Password:

Re-type Password:

Back

1 DNS for Print Service: The host name is tied to a Print service, rather than the server. The host
name must resolve to the IP address of the Appliance. You must validate that the DNS address
is correct and functional before continuing because a wrong DNS address can result in errors.

The default value is the host name of the iPrint Appliance. If you modify this value to a different
host name it allows you to move the iPrint server without interrupting the workstations. The host
name is used to connect to the Windows and Mac desktop clients.

NOTE: If you configure a Remote Driver Store, you must manage (using iManager) the Remote
Driver Store from the machine where the Driver Store resides.

2 Authentication Realm: Specify the tree name only if you want to authenticate to an existing
OES server.

In an OES iPrint server, the Authentication Realm is the eDirectory tree name. When a user logs
in to the workstation with NetlQ eDirectory credentials, the credentials are shared with the iPrint
Client to provide seamless login experience to all the iPrint servers in your tree.

3 iManager Credentials: The credentials in this section are used to log in to the iManager
interface. In the earlier release this label was Embedded Data Store.

Administrator Username: The administrator account user name is pre-populated in the
following format: cn=admin, o=iPrintAppliance. This field is not editable.

Administrator Password: Specify the password for the iManager administrator account. This
password will be used to log in to the iManager for managing the print environment.
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Re-type Password: Specify the password again to confirm.
4 Click Finish.
After configuring iPrint Appliance, you must create or import users, create or import printers, and

upload drivers. You can also configure printers to accept print jobs from mobile devices, AirPrint, or
email.

Creating Printers

Before configuring the printer, you must create the printer object on the iPrint Appliance. You can use
any one of the following methods to add printers to iPrint Appliance.

+ Section 5.2.1, “Migrating Printers from an OES iPrint Server,” on page 37

+ Section 5.2.2, “Creating Printers Using iManager,” on page 43

+ Section 5.2.3, “Bulk Printer Import Using a CSV File,” on page 44

Migrating Printers from an OES iPrint Server

During process of migration iCM settings and ACLs are automatically migrated to the iPrint Appliance
and depending on your selection printers, drivers, driver profile, and printer configuration details are
migrated.

Prerequisites

+ All users are migrated from OES to iPrint Appliance by using Import Users/ Groups task from
Management Console. For information on how to import users from an LDAP source, see
Section 9.1.10, “Import Users,” on page 99.

+ Enable SSH service on the appliance. To enable SSH, see Section 8.6, “System Services,” on
page 84. By default, the ssh service is disabled.

Migrating Printers

1 The Migration GUI must be launched from your Windows, Linux or Mac machines. Using iPrint
Appliance you cannot launch the Migration GUI.

la To connect to the iPrint Appliance by using Windows (SSH):

lal Launch SSH Client and connect to the iPrint Appliance. You must have X server
running on your computer.

1b To connect to the iPrint Appliance by using Linux or Mac:
1b1 Launch the terminal, then run the command ssh -X <iPrintApplianceIPaddresss.
2 Log in as the root user and at the command prompt, enter miggui.

3 (Optional) Click Save Project. If you save a project, the next time you want to import printers, you
can use the saved file to retrieve your preferences instantly.

4 Specify the credentials to authenticate to the source and iPrint Appliance server.

If the source server is OES 2 SP3, OES 11, or OES 2015, specify the password for
authentication in the root Password field.
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ﬁ Source Server Authentication Pr— E

Server: |192.168.1.255 [v]
(e.g. 192 168 xxx Ky ar Host Mame)
[ |15 Cluster Resaurce

User Mame ||:n=admin,|:|=n|:wEII |v|

fe.0. ch=admin, o=campanyname)

Password |"--" |

root Passwaord : |"--u |

l [(Fequired for OES Linux server) l
. L]
| Port: 636 =] 7] Use 5L
I3
@ Help B oK € Cancel
(-
' X
A Target Server Authentication —
Uzer Mame : ||:n=admin,|:|=n|:wEII |v|
(e.0. cn=admin, o =companyname)
Password : |""" |
root Password ! |""-- |
I Port: |626 | | [v] Use 5L I
12 |
|
® Help [ oK € Cancel
5 Click Add.

6 Select Micro Focus iPrint, then click OK.
7 In the Configure Service dialog box, click Yes. The iPrint configuration windows is displayed.
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iPrint Migrationi(on wgp-print-231)

[_Print Options | other Options |

Print Managers

Select printers from Source printers list to migrate,

Source Print Manager : | |

[] eDirectory Server* :

*In case the Target Server does not hold a ebirectory replica

Printer Objects

SOuUrce printers: [ "Printer with same name exists on Target cantext)
Select | Printer Agents Cantext
[ ]select Al Filter |

Create Target printer objects in:

() Context same as Source grinter context

® Target context: | |

[ ] Do Mot Migrate Existing Target Printers

Target Print Manager : ||:n=print_manager,n=iprintappliance | Get Printers

[ Ea ][ O |

For mare informatiaon, refer to [Print Migration Best Practices Guide,

[»

4

8 Configure the following parameters to proceed with the migration process:

Print Objects Parameter Description

Print Managers Source Print Manager  Specify the active Print Manager on the source server. The
source Print Manager can be either an NDPS manager (for
NetWare 6.5) or iPrint Manager (OES 2 SP3, OES 11, or OES
2015). To go directly to a context of your choice, specify the

context in the search base and click Search. The objects in the

specified context are displayed.
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Print Objects Parameter

Description

Target Print Manager

Printer Objects Source printers

Select All

Filter

Create target  Context same as
printer objects source printer context
in

Target context

Do Not Migrate Existing
Target Printers

The Target Print Manager field is populated with the name of
the active Print Manager running on the target server. This field
is editable; you can also specify a different name for the active
Print Manager. To go directly to a context of your choice,
specify the context in the search base and click Search. The
objects in the specified context are displayed.

Click Get Printers to select printer objects from the source Print
Manager.

Displays all printers of the active Print Manager available on
the source server. The printers that already exist on the target
server are indicated by an asterisk (*).

Selects all the printers listed in the Printer Objects dialog box.

NOTE: When you apply a new filter or modify an existing filter
and click Select All, only printers that are displayed after
applying the filter are selected. When you manually select all
printers, the selected printers are migrated.

Specify the search pattern in the Filter field. This displays the
printers in the Printer Agents list. This field is case sensitive.

Select this option to use the same context as the source
printers on the target server.

This option is selected by default. It allows you to create source
printers under a different context on the target server. This
option does not maintain the context hierarchy of the source
printer.

To go directly to a context of your choice, specify the context in
the search base and click Search. The objects in the specified
context are displayed.

If the printer names on the source server match the printer
names on the target server, the target printer properties and
attributes are overwritten by the source printer properties and
attributes.

The printers that already exist on the target server are
represented by an asterisk (*).
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iPrint Migrationi(on wgp-print-231)

Print Options | Other Options | T
Source Driver Store
[ ] The Source Driver Store is not on the same Server as the Source Print Manager
IP Address/DMS Mame .
User Mame :
Fassward
Migrate the following additional source Print Brakers to the Target Driver 3tore:
IP Address/DMS Mame Braker volume Mame
Target Driver Store
Target Driver 5tore DM D
[] Target Driver Stare is remote
IF Address/DMS Mame :
ser Mame :
Password : i
Printer Drivers
Ciptions to Migrate Printer Drivers:
) Do Mot Migrate Printer Driver and association of the Printer Agents with the Driver.
) Migrate Printer Driver if the driver is not present in the Target Driver Store.
3 Migrate all Printer Drivers. T?’Ei mverwrites the Printer Driver an the Target Diriver Store.
Migrate drivers for the followitg platforms:
All =
Windows 93/98 =
Windows NT 4 —
Windows 2000
Windows XP - |
Press Ctri+ Click to select ar deselect more than one platform
Migrate Printer Driver Profiles. This owerwrites the existing Printer Driver Profiles
Migrate iPrint.ini file. Thiz overwrites the existing iPrint.ini file on Target
@ Help | [ ox | ‘ @Qancel
For mare informatiaon, refer to [Print Migration Best Practices Guide, |
Other Options Parameter Description
Source Driver  The Source Driver If the source Driver Store is running on a server different from
Store Store is not on the the source Print Manager's server, this check box is selected.
same server as the .
Source Print Manager ~ SPecify the IP address or the host name and the root password
of the server on which the source Driver Store is located.
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Other Options Parameter

Description

Target Driver
Store

Printer Drivers

Printer Driver
Profile

iPrint.ini File

Migrate the following
additional Source Print
Brokers to the Target
Driver Store

Target Driver Store is
remote

Do not Migrate Printer
Drivers and the
association of the
Printer Agents with the
Driver

Migrate Printer Driver if
the driver is not present
in the target Driver
Store

Migrate all Printer
Drivers. This overwrites
the Printer Driver on
the target Driver Store

Migrate Printer Driver
Profile

Migrate iPrint.ini File

This section lists the names and IP/DNS addresses of the
source Print Broker volumes that must be migrated to the target
Driver Store.

Click the plus button (+) and specify the IP address or the host
name of the Source Broker. Select the Source Broker volume
from the drop-down list and click OK. The list is populated with
the IP address or host name of the Source Broker and Broker
volume name. You can add multiple Source Brokers to the list.

To remove the Source Broker from the list, select the IP
address or host name and click the minus button (-). You can
remove one Broker at a time.

If the Driver Store is running on the remote server (other than
the target server), the Target Driver Store is remote check box
is enabled.

Specify the IP address or the host name of the remote server
and the root password of the remote server in the
corresponding entry fields.

Selecting this option ensures that printer drivers and the
association of Printer Agents with the drivers are not migrated.

Selecting this option migrates the printer drivers for the
selected driver platforms from the Select Driver Platforms to
Migrate list, if they are not present in the target Driver Store.
This also migrates all the associations of the Printer Agents
with the driver.

NOTE: The default driver platform selection is All.

Selecting this option overwrites the target drivers for the driver
platforms you have selected from the Select Driver Platforms to
Migrate list, if the driver names in the target Driver Store are the
same as the source Driver Store. This also migrates all the
associations of the Printer Agents with the driver.

NOTE: The default Driver Platform selection is All.

If the profiles are the same on the target server as the source
server, the target profiles are overwritten.

If you migrate printer agents from two or more print managers,
the iPrint. ini file on the target server is replaced by the
iPrint. ini file of the last source server.

NOTE: After migration, if the target server's iprint . ini file is
overwritten by the source server's file, and if the target server's
iprint.ini file had new parameters that were erased, you
can restore them by copying the parameters manually from the
iprint.bak file. The iprint .bak file is a backup of the
target server's iprint.ini file. After migration, the
iprint.bak file is saved in the /var/opt /novell/
iprint/htdocs directory.
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9 Click OK to finish the configuration and go back to the migration screen.
10 Click Migrate to begin the migration process.
Using iManager, you can verify the details of the migrated printers.

Creating Printers Using iManager

By default, iPrint Appliance supports only PostScript printers. For non-PostScript printers like PCL, or
for printers that do not work with the default PostScript driver, you must associate appropriate drivers
to the printers.

1 On the iPrint Appliance Management Console page, select the Manage Printers (iManager) tool
to connect to iManager.
2 Log in to iManager using the eDirectory admin credentials of iPrint Appliance.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. If you add the certificate to the trusted certificates list, the security warning is not
displayed.

3 Click iPrint > Create Printer.
4 Specify the Target printer details.

Printer Name: Defines the label by which the new printer is identified. You can include
uppercase and lowercase letters, numbers, spaces, and underscore in the label. Do not use any
other characters.

Container Name: The eDirectory container where the printer reference resides. By default, the
value is “iPrintAppliance”. We do not recommend changing the default value.

Print Manager name: The name of the Print Manager that handles the incoming print jobs.

DNS name or IP address: The IP address of a printer uniquely identifies it on the network and
allows other networked machines to communicate with it. A DNS name can also be applied to
the printer, which can be translated into the printer's IP address.

Specify the IP address (v4) or the DNS name of the target printer.

Location: Indicates the printer's location. The value of this field is displayed when selecting a
printer.

Description: Describes the printer. The value of this field is displayed when selecting a printer.

LPR Printer Name: Specify an LPR printer name. If the LPR protocol is selected, other optional
parameters can also be specified. With most modern printers, the name can be set to
PASSTHROUGH. With some older printers (1990's & prior), there might be a different printer
name.

RAW Port Number: If the RAW protocol is selected, a port number is required. Most printers are
configured, by default, to use port 9100 for RAW protocol communications.

iPrint Appliance supports printer communications using either the Line Printer Remote (LPR) or
RAW protocols.

The LPR protocol is the most common printing protocol and is generally more flexible than the
RAW protocol. A printer that supports the LPR protocol is sometimes referred to as a TCP/IP
printer. The LPR protocol has limited error reporting capabilities, which is often limited to “Printer
Error” with no details.

The RAW protocol is often the default protocol on non-Windows systems. Most printers that
support the RAW protocol use port 9100. The LPR protocol can generally be substituted for the
RAW protocol if the RAW protocol does not respond to a print job.

5 Click Next.
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6 Specify the drivers for the printer.

iPrint Appliance supports both driver and driverless printing. For mobile device printing, drivers
are not required. The selectable drivers for each operating system are available in the Micro
Focus iPrint Appliance Driver Store.

7 To reedit the printer-specific options after the new printer has been created, click Modify. To
create another printer, click Repeat Task. To continue, click OK.

In iManager, you might see a Partition and Replicas option. This feature is not supported on
iPrint Appliance.

5.2.3 Bulk Printer Import Using a CSV File

You can import printers into iPrint Appliance through a csv file. On successful import the printers
resides in the container O=iPrintAppliance.

You must create a csv file, then import the csv file into iPrint Appliance. The csv file must contain the
following fields in the same order:

PrinterName, PrinterIP, Location,Description,Win95 98 Driver,Winnt Driver,Win2k Driv
er,Winxp Driver,Linux Driver,Mac Driver,Vista32 Driver,Vista64 Driver,Win732 Drive
r,Win764 Driver,Win832 Driver,Win864 Driver,Winl032 Driver,Winl064 Driver, Enable
DirectPrinting, Secure Printing,Enable Auditing, LPR/RAW,Raw Port

NOTE: You cannot enable both direct printing and auditing. If enabled, both options are disabled
when creating the printers.

Table 5-1 Parameter Description of CSV File

Parameter Description Value

(Mandatory/Optional)

PrinterName Name of the printer that you want to import Mandatory
PrinterIP IP Address assigned to this printer Mandatory

NOTE: Specify only the IP address. Printer
creation fails if host name is specified.

Location Location of the printer Optional

Description Details of the printers like make, model, and so  Optional
forth.

Win95_98_Driver Driver associated with this printer for Windows 95 Optional
and Windows 98 platform.

Winnt_Driver Driver associated with this printer for Windows Optional
NT platform.

Win2k_Driver Driver associated with this printer for Windows Optional

2000 platform.

Winxp_Driver Driver associated with this printer for Windows Optional
XP platform.

Linux_Driver Driver associated with this printer for Linux Optional
platform.
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Parameter

Description

Value

(Mandatory/Optional)

Mac_Driver Driver associated with this printer for Mac Optional
devices.

Vista32_Driver Driver associated with this printer for Windows Optional
Vista 32-bit platform.

Vista64_Driver Driver associated with this printer for Windows Optional
Vista 64-bit platform.

Win732_Driver Driver associated with this printer for Windows 7 Optional
32-bit platform.

Win764_Driver Driver associated with this printer for Windows 7 Optional
64-bit platform.

Win832_Driver Driver associated with this printer for Windows Optional
8.x (32-bit) platform.

Win864_Driver Driver associated with this printer for Windows Optional
8.x (64-bit) platform.

Win1032_Driver Driver associated with this printer for Windows 10 Optional
32-bit platform. Windows 10 uses the same driver
as Windows 8.x.

Win1064_Driver Driver associated with this printer for Windows 10 Optional
64-bit platform. Windows 10 uses the same driver
as Windows 8.x.

DirectPrinting Enable direct printing for this printer. Value is yes Optional
or no. By default, this option is disabled. You
cannot enable both direct printing and auditing.

Secure Printing Enable secure printing for this printer. Value is Optional
yes or no. By default, this option is disabled.

Enable Auditing Enable auditing of this printer. Value is yes or no. Optional
By default, this option is disabled.

LPR/RAW Protocol to be used by this printer. Value is LPR ~ Optional
or RAW. By default, the value is LPR.

Raw Port If you have selected RAW protocol, specify the Optional

port number.

IMPORTANT: In the csv file, you must specify at least one driver for each printer. For all optional
parameters, you must include a empty string.

Example of a CSV file

If you have to migrate 2 printers (printerl and printer2) for a Windows 8 32-bit platform. The csv file
includes:

printerl,10.0.0.1,1st floor,HP LaserJet 4100,,,,,,.,,,,,HP LaserJet 4100 PCL 5
llllnoryes,yeS,LPR,

printer2,l0.0.0.2,Zst_floor,HP LaserJet 4100,,,,,,.,,.,,,HP Laserdet 4100 PCL 5
, ., N0, ves,yes,RAW, 9100
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5.3

531

5.4

After you create the csv file, upload the file to iPrint Appliance.

Uploading the CSV File

1 On a Web browser, specify either the host name or the IP address. For example, https://
10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the Username and Password, then click Log in.
3 Click Manager iPrint Appliance.
4 Click Printers.
5 Click the Bulk Printer Creation button in the upper-right corner of the window.
Create Printers from CSV X
| CSV File: Browse..,
Download Sample C5V (04 Cancel

5a To download the sample csv file, click Download Sample CSV.

6 Navigate to the .csv file, select it, then click OK to begin the printer import process.

To enable printing from mobile devices, proceed to Section 5.5, “Configuring Printing Through Mobile
Devices,” on page 53.

Creating or Importing Users

You can either import your users from an existing LDAP eDirectory or Active Directory source, or you
can create local users on iPrint Appliance.

¢ Section 5.3.1, “LDAP Import from eDirectory or AD Source (Recommended),” on page 46

LDAP Import from eDirectory or AD Source
(Recommended)

To set up iPrint Appliance and import printers, you must first import users from your LDAP source. For
information on how to import users from an LDAP source, see Section 9.1.10, “Import Users,” on
page 99.

Configuring Printer Drivers

A printer driver or PostScript Printer Description (PPD) file is software that directly supports a physical
printer, enabling it to carry out its functions.

Hardware vendors develop printer drivers and PPD files, which are specific to each printer. Most
printers require different printer drivers for each operating system they interact with. You can use
iManager to view a list of printer drivers and PPD files you have uploaded to the Driver Store. You can
add printer drivers and PPD files from diskettes, CDs, and the workstation operating system.
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5.4.2

iPrint Appliance ships with a default Linux driver that is used by the local renderer for mobile printing.
To modify the default Linux driver, see Section 5.4.4, “Modifying the Default Linux Driver Used by the
Local Renderer for Mobile Printing,” on page 51.

¢ Section 5.4.1, “Prerequisites,” on page 47

+ Section 5.4.2, “Uploading Drivers By Using iManager,” on page 47

+ Section 5.4.3, “Uploading Drivers By Using Command Line,” on page 50

+ Section 5.4.4, “Modifying the Default Linux Driver Used by the Local Renderer for Mobile
Printing,” on page 51

+ Section 5.4.5, “Location Of the Linux Printer Drivers,” on page 52

Prerequisites

+ Install iPrint Client. For more information, see Section 10.1, “Installing the iPrint Client,” on
page 155

Uploading Drivers By Using iManager

iManager is a management tool that allows you to manage your print environment. You can create
printers, printer drivers, profiles, and users.

Supported Browsers to Upload Drivers Using iManager

Workstation Supported Upload Linux Upload Windows  Upload Mac
Browser Drivers Driver Drivers
(PPD file) (.inf file) (PPD file)
Linux Windows Mac
Windows Internet Explorer v e v

6.0 or later (run as

administrator) Same version as

the workstation

Mac Not supported % x x

NOTE: If you are running iManager from a Windows workstation, you can only add printer drivers for
that version of Windows.

You cannot upload drivers from a Windows Server platform. To print documents from your Windows
server, you must upload the drivers from the Windows workstation that can work with the server
platform. For more information, see “Windows server and workstation Map” on page 50.

Uploading Drivers to the Driver Store

To upload printer drivers to the Driver Store:

1 In iManager, click iPrint > Manage Driver Store.
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48 Manage Driver Store

Specify the object(s) to modify.
Select a single object | Simple Selecticn

iPrint Driver Store name:

driver_store.iPrintAppliance

oK |  cancel |

2 Specify the name of the iPrint Driver Store to which you want to add printer drivers.
3 Select the Drivers tab.

Manage Driver Store: ggdriver_store.iPrintAppliance

Driver Store Control | Access Control 0=

-
Drivers Platform:
Windows 7 (64 bit) v
Current drivers:
Adobe POF Converter - Add From File
Brady IPE00 Printer
Brother HL-2250DN series _Add From System |
Brother HL-3040CN series
Brother HL-3070CW series InetEt—

Brother HL-4040CN series

Brother HL-4050C0ON BR-Script3

Brother HL-4050C0N series

Brother HL-4150C0N series

Brother HL-4570CDW BR-Script3 -

4 Use the Drivers Platform drop-down list to select the client platform for which you want to add the
printer driver.

5 Perform one of the following actions:
¢ Click Add from File to add printer resources from a printer driver (. inf file or ppD) file.
Mac: The standard file format is PPD (Postscript Printer Description) file.
Windows: The standard file format is . inf file.
+ Click Add from System to add drivers from the workstation where you are running iManager.

The drivers installed on your workstation are only available to be uploaded to the Driver
Store.

6 Select a driver, then click OK.
7 Click OK to save your changes.

To display the changes you made, click Refresh.

Deleting Drivers from the Driver Store

1 IniManager, click iPrint > Manage Driver Store.
2 Select the Drivers tab.
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3 Read the list of existing printer drivers displayed in the Current Drivers panel.
4 Select a driver, then click Delete.

5 Click OK to save your changes

6 Click Refresh to refresh the screen and display the changes you just made.

Associating the Driver
To set the default driver:

1 IniManager, click iPrint > Manage Printer.

4 Manage Printer

Specify the object(s) to modify.

Select a single object | Simple Selecticn

iPrint Printer name:

MacTest Printer2. iPrintAppliance

oK |  cancel |

2 Specify the name of the printer to which you want to set the default driver.
3 Select the Drivers tab.

Manage Printer: ¢gpMacTest Printerl.iPrintAppliance

Printer Control ULV Access Control | Configuration | Client Support |

Drivers Platform:
Mac v

Mac current setting
Driver:
Profile:
Model:

Available drivers:

[None]

Brother HL-4070CDW BR-Script3
Brother HL-4150CDN BR-Script3
Brother HL-5450DN series CUPS
Canon IR3235/IR3245

Dell 2330dn Laser Printer

Dell B2360d-dn Laser Printer
Dell Laser Printer W5300 PS3 -

Available driver profiles for selected driver:
[None]

4 Use the Drivers Platform drop-down list to select the client platform for which you want to set the
printer driver for the selected printer.

5 In the Available drivers, select the printer driver you want to associate with the selected printer.
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This field displays a list of printer drivers that have been uploaded for this operating system. If
you do not want a printer driver to be used, select None.

NOTE: If no printer driver is selected, you cannot print from a desktop client to that printer. For
mobile printing, the default driver will be used to render jobs for that printer.

Windows server and workstation Map

Windows Desktop Windows Server
Windows XP (32-bit) Windows 2003

Windows Vista (64-bit) Windows 2008

Windows 7 (64-hit) Windows 2008 R2
Windows 8 or 8.1 (64-bit) Windows 2012 or 2012 R2
Windows 10

For example, To print from Windows 2008 server, associate the printer with Windows Vista driver.

5.4.3 Uploading Drivers By Using Command Line

You can upload drivers from your workstation or from an iPrint Appliance server.

+ “Workstation” on page 50
+ “iPrint Appliance Server” on page 50

Workstation

iprntcmd is a command-line utility that helps you manage iPrint tasks on your workstation. To upload
the drivers to the driver store, run the following commands on your workstation:

Windows Client: Execute the following command:
iprntemd -U <ids address> <username> <password> <INF paths>

where ids_address is the IP address or host name of the driver store, username and password are
credentials of the user who has rights to add the drivers to the driver store and INF path is the path of
the printer driver file.

Mac Client: Execute the following command:
iprntemd -u <ids uri> <PPD path>

where ids_uri is the IP address or host name of the driver store, and PPD path is the path of the
printer driver file.

iIPrint Appliance Server

iprntman is a command-line utility that helps you manage iPrint tasks on the iPrint Appliance server.

Linux: Execute the following command:
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iprntman driver linux --upload --from-ppd <PPD path> -u <eDir username> -P <eDir
passwords>

where PPD path is the path of the printer driver file, eDir username and password are credentials of
the eDirectory user who has rights to add the drivers to the driver store.

54.4 Modifying the Default Linux Driver Used by the Local
Renderer for Mobile Printing

iPrint Appliance ships with a default Linux driver that is used by the local renderer for mobile printing.
Remote renderer does not include any driver, you must upload the drivers available in the driver
store.

To modify the default Linux driver:

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

Micro Focus*
IPrint Appliance

8) i
& vaadmin

ffi r—

Signin

B [2015) Novell, Ine., a8 Miero Foeus company. All
rights reserved.

2 Specify root or vaadmin as the user name.

3 Specify password. This password was created when you performed the Initial configuration of
the iPrint Appliance.

The Appliance Console page is displayed.
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4 Click Manage iPrint Appliance.

iPrint Appliance
Canfiguration

5 Under Configuration, click Renderers.
6 On the Renderers Configuration page, select the iPrint Local Renderer, then click Edit.

a0e

7 In the Default Printer Driver drop-down list, select the driver that you want to set as default for the
local renderer.

NOTE: The drivers from the driver store are listed in the Default Printer Driver field.

Edit Renderer X

Renderer Name: iPrint Local Rendersr

Default Printer Drivar: Generic PostScript Printer Foomatic/Postscript (re| v

Commit Cancel

If a printer does not have a driver associated to it, the default printer driver is automatically used
to print the documents.

545 Location Of the Linux Printer Drivers

iPrint Appliance ships with a default Linux driver that is uploaded to the Driver Store and used by the
local renderer for mobile printing.

If you want to modify the default Linux driver, the appliance is also bundled with additional Linux
printer drivers. To associate the drivers, you must upload the drivers to the Driver Store. The location
of the drivers is /usr/share/cups/model and /usr/share/cups/model /manufacturer-PPDs/
hplip.

To extract the relevant driver, execute the following command:
gunzip <path to ppd.gz>

For example, gunzip /usr/share/cups/model/epson24.ppd.gz
Using iManager or CLI, you can upload the drivers to the Driver Store.

You can also download the Linux drivers from the OPEN PRINTING (http://www.openprinting.org/
printers) website and then upload to the Driver Store for association.
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5.5 Configuring Printing Through Mobile Devices

You can configure printers to accept print jobs through mobile devices, AirPrint or email.

¢ Section 5.5.1, “Configuring for Mobile Printing,” on page 53
+ Section 5.5.2, “Configuring for Email Printing,” on page 53

+ Section 5.5.3, “Printing Using Email,” on page 57

+ Section 5.5.4, “Printing via AirPrint,” on page 57

¢ Section 5.5.5, “Generating QR Code for Printer,” on page 58

55.1 Configuring for Mobile Printing

1 On a Web browser, use either the host name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. If you add the certificate to the trusted certificates list, the security warning is not
displayed.

2 In the Micro Focus iPrint Appliance Configuration login page, enter the user name as vaadmin,
enter the password that you specified for vaadmin, then click Log in.

3 Click Manage iPrint Appliance.
4 Under Configuration, click Printers.

The printers listed in this screen can be enabled for AirPrint, Mobile, and Email printing for iPrint
Appliance.

5 Select the printer that you want to configure. You can choose multiple printers at a time by
holding the Ctrl key.

The AirPrint, Mobile and Configure drop-down menus are activated.

6 To configure the printers for Mobile printing, click the Mobile drop-down menu, then select

Enable.

Printers Configuration (2]
AirPrint™ « Mobile + Configure + Refresh
Name AirPrint™ Mobile Printing Email Secure Location Description
&= HP-Laser Jet «

5.5.2 Configuring for Email Printing

iPrint Appliance contains an email printing feature. Using email printing, you can print documents
from any device capable of sending emails. You can print emails by specifying email printing
commands in the subject line of the email. You can also print documents by emailing them to your
printer as attachments.

When you enable email printing, the email address you provide becomes the global print email
address. You can also configure a printer for private email printing by providing a specific email
address to each printer.
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The difference between global email printing and private email printing is:

+ Global Email Printing: When you enable email printing, you are prompted to specify an email
address. This email address is the global print email address. When configured for email
printing, iPrint Appliance becomes a client to an email server. The global email account inbox is
polled for incoming print jobs, which are then routed to the intended printer.

+ Private Email Printing: With private email printing, you can assign a specific email address to
each printer. When a user sends an email printing request, the print job is sent directly to the
printer. Users do not need to specify any print commands in the subject line of the email.

Email printing is not enabled by default. You can enable email printing through the Management
Console. You must create a unique email address for iPrint Appliance to receive and process print
requests. For more information on enabling Email, see “Global Email Settings” on page 96 and
“Enabling Private Email Printing” on page 90.

IMPORTANT: If you enable auditing for email print jobs, the email address of the user is logged in the
iPrint audit logs. If the same email address is populated for the user object in the LDAP source, then
the user FDN is logged instead of email address. This is important if you are using an accounting
software to ensure that jobs are tracked or accounted correctly.

+ “Email Printing Commands” on page 54

Email Printing Commands

You can print the body of the email and the attachments by using a few simple print commands in the
subject line of your email.
+ “Basic Print Commands” on page 54

+ “Additional Print Commands” on page 55

Basic Print Commands

help
Provides information on email printing commands.

list printers
To get the names of the available printers, send an email to the iPrint server address (for
example, iprint@example.com) with the subject line 1ist printers.

print printer=<printer name>

Prints your email and its attachments to the specified printer. For example, print
printer=hp#Test Mail.

If you print to a specific printer by using the printer’s email address, the print printer
command is ignored.
hold printer=<printer name>

Queues your email along with its attachments and sends you the job ID as acknowledgement.

resume
Resumes the printing of a job that you put on hold. There are two ways to print a job on hold:
+ Send an email with subject resume followed by the job ID. For example, resume 10

+ Send an email with the original subject line prefixed with resume. For example,
resume#Test Mail
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cancel
Cancels a job that you put on hold. There are two ways to cancel a job on hold:
+ Send an email with subject cancel followed by the job ID. For example, cancel 10
+ Send an email with the original subject line prefixed with cancel. For example,
cancel#Test Mail
status
Displays the status of a job. There are two ways to check the status of a job:
+ Send an email with subject status followed by the job ID. For example, status 10
+ Send an email with the original subject line prefixed with status. For example,
status#Test Mail
move
Moves a job to a new printer. There are two ways to move a job to a new printer:

+ Send an email with subject move, the job ID, and the name of the new printer. For example,
move 10 printer=<PrinterNames>

+ Send an email with the original subject line prefixed with move, the name of the new printer,
and #. For example, move printer=<PrinterName>#Test Mail
list jobs
Lists the details of the held jobs.

default printer

Displays the default printer.

default printer=<PrinterName>

Sets a particular printer as your default printer. After you set the default printer, you do not need
to include the printer name while printing to the default printer. You only need to use the print
command followed by the email subject. For example, print#Test Mail.

NOTE: If a printer name contains spaces, enclose the printer name within double (") or single (')
guotes. For example, print printer='HP PRINTER'.

NOTE: To separate the email subject from the command, use #. For example, print
printer=hp#Test Mail.

Additional Print Commands

In addition to the basic print commands listed above, you can use these commands to refine your
printing:
portrait [portrait=yes/portrait=y (or) portrait=no/portrait=n]

Prints your email content in portrait orientation. For example, print printer=hp
portrait=y#Test Mail

landscape [landscape=yes/landscape=y (or) landscape=no/landscape=n]

Prints your email content in landscape orientation. For example, print printer=hp
landscape=y#Test Mail
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color [color=yes/color=y (or) color=no/color=n]

Prints your email content in color. For example, print printer=hp landscape=y
color=y#Test Mail.

pages

Prints a given range of pages in your email. For example, the command print printer=hp
landscape=y color=y pages=1-3#Test Mail prints pages 1, 2, and 3.

copies

Prints the specified number of copies of your email and its attachments. For example, the
command print printer=hp landscape=y color=y pages=1-3 copies=5#Test Mail prints
5 copies of pages 1, 2, and 3.

duplex [duplex=yes/duplex=y (or) duplex=no/duplex=n]

Prints your email and its attachments on both sides of the printing paper. For example, the
command print printer=hp landscape=y color=y pages=1-3 copies=5
duplex=y#TestMail prints 5 copies of pages 1, 2, and 3 in duplex mode.

media

Prints your email and its attachments with the specified paper type. The default paper type is
“LETTER.” You can change the default paper type by using the iPrint Appliance Management
Console. The other available print paper types are A3, A4, and other common paper types. For
example, the command print printer=hp landscape=y color=y pages=1-3 copies=5
duplex=y media=A3#Test Mail prints 5 copies of pages 1, 2, and 3 in duplex mode, on an A3
size paper.

mailbody [mailbody=yes/mailbody=y (0r) mailbody=no/mailbody=n]

Prints either your email and its attachments or only the attachments from your email without the
email body. For example, using the command print printer=hp landscape=y color=y
mailbody=n#Test Mail prints only the email attachments in landscape mode.

NOTE: If you do not specify any of the additional commands, your print job is carried out according to
the default preferences set by your administrator.

IMPORTANT: When printing to a specific printer using the printer’s private email address, you do not
need to specify the printer’s name in the command. You can also leave the subject line empty.
Printing is carried out according to the default print options set by the administrator.

However, you must specify the print command in the following scenarios:

¢ The administrator changes the subject optional for printer specific emailsto Falsein
the iPrint Appliance Server Configuration file located at /etc/opt/novell/iprintmobile/
conf/iprintmobile.conf.

+ If you want to customize the print options, you must specify the print command, along with the
required print options. For example, print landscape=y color=y pages=1-3 copies=5
duplex=y media=A3#Test Mail.
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5.5.3

5.5.4

Printing Using Email

Using email printing, you can print documents from any device capable of sending emails. You can

print emails by specifying email printing commands in the subject line of the email. You can also print

documents by emailing them to your printer as attachments.
Ensure to meet the following prerequisites:

+ Appliance is configured with global or private email address. For example, iprint@example.com
+ The users are provided with the appliance configured email address

+ List of printers configured for email printing
Perform the following steps to print using email:

1 Open an email. You can use any email mail box.

2 In the To field, specify the appliance configured email address. For example,
iprint@example.com

3 In the Subject field, specify the commands from the “Email Printing Commands” on page 54
section.

For example,
+ To print from a printer named printerl, print printer=printeril
+ To view list of printers that are available to print, list printers
+ To view the list of commands, help
4 Specify the information to print in the body of the message or add an attachment to print.
5 Click Send.
The document is printed and a confirmation message is received in the mail box.

Printing via AirPrint

AirPrint is an Apple technology that facilitates printing without the need to download or install drivers.

AirPrint enables easy discovery, automatic selection of media, and so on.

Mac, iPhone, iPad, or iPod touch users can use AirPrint to print over wireless network to AirPrint
enabled printers.

Enabling AirPrint through iPrint
1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
Specify vaadmin oOr root as the user name.
Specify the password, then click Log in.
Click Manage iPrint Appliance.

Under Configuration, click Printers.

o 01 A W N

Select a printer for which you want to enable AirPrint.

Currently only “HP LaserJet 500 color MFP M570dw” printer model is supported for AirPrint
printing.
7 Click the AirPrint drop-down menu, then click Enable Advertising.
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5.6

iPrint AirPrint is now enabled on the iPrint printer. You can print to an iPrint AirPrint enabled printer
from any iOS device.

Disabling AirPrint through iPrint

To disable AirPrint through iPrint:
1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
Specify vaadmin or root as the user name.
Specify the password, then click Log in.
Click Manage iPrint Appliance.
Under Configuration, click Printers.

o 00~ WN

Select a printer for which you want to disable AirPrint.
The AirPrint and Mobile drop-down menus are activated.
7 Click the AirPrint drop-down menu, then click Disable Advertising.

Generating QR Code for Printer

User can scan a QR code to select a specific printer on their mobile device. To generate the QR code
for the printer, perform the following steps:
1 Create a QR code using any QR code generator.
The generator might include multiple formats, ensure to use Plain text format.
The format to use is ipp://<server ip or host name>/ipp/<printer name>
where the printer name is case-sensitive.
2 Print the generated QR code and paste it on the printer.

What's Next

iPrint Appliance is now configured for printing through desktop, laptops, and mobile devices. You can
start printing to iPrint printers.

+ For desktop-quality printing on your mobile devices, it is highly recommended that you install the
remote renderer. You can download the remote renderer from the iPrint Appliance Management
Console. To install and configure the remote renderer, see Section 7.3, “Installing and
Configuring a Remote Renderer,” on page 66.

+ For managing iPrint Appliance, see Chapter 9, “Managing Print System,” on page 89.
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6.1

6.2

Migrate Existing iPrint Appliance

Appliance migration copies the configuration settings from an existing appliance and setting up the
new appliance with the same network details.

Depending on whether a configuration zip file is available or a secondary disk is attached, the GUI
provides options to proceed with migration:

¢ Section 6.1, “Prerequisites,” on page 59

+ Section 6.2, “Migrating from 1.1 to 2.0,” on page 59

+ Section 6.3, “Migrating from 2.0 to 2.x,” on page 61

+ Section 6.4, “Post-Migrate,” on page 62

+ Section 6.5, “Exporting the Configuration File,” on page 62

Prerequisites

Failure to comply with any of the following critical points can result in a non-functional iPrint
Appliance.

+ Configuration file (iprintconfig.zip) of the earlier version of appliance or secondary disk that
includes the earlier version configuration file.
+ Print pending jobs: Ensure to print or cancel any pending jobs.

+ Remove all snapshots prior to upgrading an appliance: To ensure that correct disk file and
the latest configuration settings get migrated.

+ Meet all hardware and software requirements: See Chapter 3, “Planning Your Print
Environment,” on page 21.

+ Patch the appliance: See Section 8.10, “Field Patch,” on page 86.

+ You cannot migrate directly from iPrint 1.0 or 1.0.1 to iPrint 2.0: You must first migrate to
iPrint Appliance 1.1, apply all patches, ensure that all desktop clients are updated, and then
upgrade to iPrint Appliance 2.0.

Migrating from 1.1to 2.0

You can migrate from iPrint Appliance 1.1 to 2.0 using a configuration file (iprintconfig. zip).

Ensure that the copy of the configuration file (iprintconfig. zip) of the earlier version of the
appliance is available before performing migration.

1 Create a copy of the configuration file (iprintconfig.zip) of the earlier version of the
appliance. For more information, see Section 6.5, “Exporting the Configuration File,” on page 62.

2 Shut down the earlier appliance. The new appliance will be configured with the same IP and
network settings.

3 Deploy iPrint Appliance with any virtualization software that can run the .ovf, .vhd, or .xen file
formats. For more information, see Section 4.1, “Configuring Virtual Environment,” on page 27.
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4 When the appliance is powered on, click the Console tab. Ensure you provide the same network
configuration, passwords, and time zone as that of the earlier version of iPrint Appliance from
which you exported the iprintconfig.zip configuration file.

The iPrint Appliance installation is now complete.

5 On a Web browser, use either the host name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. To avoid the security warning prompt every time you access the iPrint Appliance
Management Console, you can add the certificate to the trusted certificates list on your browser.

6 Specify vaadmin oOr root as the user name.
7 Specify the password, then click Log in.
8 Click Migrate Existing iPrint Appliance.

@ iPrint Appliance Configuration

( Create New iPrint Appliance )

Migrate Existing iPrint Appliance

« Modify Settings Getting Started

9 In the Configuration File option, click Browse..., then select the configuration file exported from a
previous copy of iPrint Appliance. For more information about the iprintconfig.zip, see
Section 6.5, “Exporting the Configuration File,” on page 62.

. Migrate iPrint Appliance

Specify the configuration file (zip) from an earlier
version of the iPrint Appliance

Configuration File:

Browse... | Mo file selected.

Specify the iManager password that was used to
configure the earlier version of iPrint Appliance.

Username:

cn=admin, o=1PrintAppliance

Password

Back
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10 Specify the iManager password that was used to configure the earlier version of the iPrint
Appliance.

11 Click Finish.

The time taken to complete the configuration depends on the size of the earlier version
configuration file. On successful migration, the appliance reboots the VM.

6.3 Migrating from 2.0 to 2.x

1 Shut down the earlier appliance. The new appliance will be configured with the same IP and
network settings.

2 Deploy iPrint Appliance with any virtualization software that can run the .ovf, .vhd, or .xen file
formats.

3 Attach the secondary disk of the earlier version of the appliance. This disk includes all the
configuration settings of the earlier appliance.

4 Power on the appliance.
5 On the Console tab, enter the root and vaadmin password for the new appliance.
The iPrint Appliance installation is now complete.

6 On a Web browser, use either the host name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. To avoid the security warning prompt every time you access the iPrint Appliance
Management Console, you can add the certificate to the trusted certificates list on your browser.

7 Specify vaadmin oOr root as the user name.
8 Specify the password, then click Log in.
9 Click Migrate Existing iPrint Appliance.

. iPrint Appliance Configuration

\/ Migrate Existing iPrint Appliance /\

% Previous appliance configuration detected.

« Modify Settings Getting Started

10 The iManager user name field is pre-populated and not editable. Specify the iManager password
that was used to configure the earlier version of the iPrint Appliance. This password will be used
to log in to the iManager for managing the print environment.
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11

. Migrate iPrint Appliance

Specify iManager password of the previous iPrint
Appliance

Usemame
cn=admin o=iPrintAppliance

Password:

Back

Click Finish.

The time taken to complete the configuration depends on the size of the earlier version
configuration file. On successful migration, the appliance reboots the VM.

6.4 Post-Migrate

*

If you have an existing remote renderer, then post-migration of appliance, the renderer might be
in an inactive state. To make the renderer active, stop and restart the renderer. After activating
the renderer you must upgrade it. For more information, see Section 7.4, “Upgrading the Remote
Renderer,” on page 70.

6.5 Exporting the Configuration File

To create the iprintconfig.zip file, you must copy the configuration information from an existing
iPrint Appliance 1.1.

1

On the iPrint Appliance, either use host name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning.
Specify vaadmin or root as the user name.
Specify the password.

The Management Console page is displayed.

4 Click the iPrint Appliance Configuration icon.

5 Under Configuration, click Export Configuration.

6 Specify the eDirectory administrator Password, then click Export.

This is the password that you use for the administrator account of iPrint Appliance when using
iManager.

On successful export, the file is available for download.

Click Download the last exported configuration file. This downloads the iprintconfig.zip file
that contains the configuration information.
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7 Document Rendering

7.1

7.1.1

iPrint Appliance provides a client-independent and driverless printing environment to mobile users.

+ Section 7.1, “Overview,” on page 63

+ Section 7.2, “Key Features,” on page 64

¢ Section 7.3, “Installing and Configuring a Remote Renderer,” on page 66
+ Section 7.4, “Upgrading the Remote Renderer,” on page 70

+ Section 7.5, “Managing the Remote Renderer,” on page 70

+ Section 7.6, “Remote Renderer Commands,” on page 72

Overview

What Is a Renderer?

iPrint now supports printing from mobile devices that have limited abilities to convert documents into
print-ready formats. On desktop platforms, the documents are usually converted to print-ready
formats by the application, driver, and the spooler subsystems. This functionality is primitive or non-
existent in many of the mobile devices and hence must be provided by the Print Service. To facilitate
this, iPrint now provides Rendering and Conversion capabilities in the product and can convert and
render most of the documents that are submitted by a mobile device, email, or other submission
methods.

This conversion (rendering) is performed on the iPrint Appliance using our built-in solution known as
Local Renderer. Printing quality varies, depending on the document complexity so for enhanced
desktop-quality printing, you can use the Remote Renderer on a Windows platform.

You can view the Local renderer and list of remote renderers in the Management Console > iPrint
Appliance Configuration, Renderers page.

The renderers support broad range of document formats. For more information, see Section B.7,
“Supported Document Formats By the Local Renderer and Remote Renderer,” on page 201.

Local Renderer

iPrint Appliance is bundled with a built-in document renderer known as Local Renderer. The renderer
converts documents to the PDF format, and then converts them to the print-ready format using
CUPS. The renderer supports multiple formats, has a multithreading feature, and provides limited
support for Microsoft Office formats. If a printer does not have a driver associated with it, the default
printer driver PostScript 3 is automatically used to print documents.
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7.1.2

1.2

7.2.1

1.2.2

Remote Renderer

iPrint Appliance also ships with a Remote Renderer. For enhanced desktop-quality printing, you can
use the Remote Renderer. The remote renderer can be downloaded from the iPrint Appliance
Management Console and installed on a Windows 64-bit computer.

The remote renderer provides high quality rendering for different formats. The remote renderer job
might take some additional time to complete the print jobs in comparison to the local renderer. If you
do not want to use the built-in PDF renderer, you can also install Adobe Acrobat Pro for PDF
rendering. However, printing PDF using a built-in pdf renderer there can be some minor print quality
differences such as color shade difference in the PDFs.

The remote renderer communicates with iPrint Appliance for document conversion. Although, it is not
a mandatory requirement for iPrint Appliance, the remote renderer is recommended for desktop
quality printing.

Key Features

¢ Section 7.2.1, “Multi-driver Support,” on page 64

¢ Section 7.2.2, “Secure and Non-secure Communication Support (Remote Renderer),” on
page 64

+ Section 7.2.3, “Automatic Printer Driver Updates,” on page 65

+ Section 7.2.4, “Printer Rename and Redirection (Remote Renderer),” on page 65

Multi-driver Support

On iPrint Appliance, you can configure the local and remote renderer to use multiple drivers for
different mobile enabled printer agents. The renderer installs the unique drivers associated with
various mobile enabled printer agents, on the renderer machine. During the rendering of jobs, the
correct printer driver is selected based on the printer agent to which the job is being submitted for
rendering.

If a printer agent does not have any driver associated with the renderer platform, the renderer uses
the default driver for rendering the jobs sent to those printer agents. You can select a default driver
when adding a renderer from the Management Console. The Management Console also provides an
option to change the default drivers.

For information on how to upload drivers to the Driver Store, see Section 5.4, “Configuring Printer
Drivers,” on page 46.

Secure and Non-secure Communication Support (Remote
Renderer)

On iPrint Appliance, the remote renderer can communicate over secure and non-secure channels
with the iPrint Appliance. By default, the iPrint Appliance is set to communicate in both secure and
non-secure modes.

Secure Communication Mode: When this mode is used, only the secure remote renderers can
communicate with the iPrint Appliance. For information on how to configure the iPrint Appliance and
renderer in a secure mode, see “Secure Communication Mode” on page 68.
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7.2.3

1.2.4

Non-secure Communication Mode: When this mode is used, both secure and non-secure remote
renderers can communicate with the iPrint Appliance. For information on how to configure the iPrint
Appliance and renderer in a non-secure mode, see “Non-secure Communication Mode” on page 69.

Non-secure communication mode is desirable in the following scenarios:
+ Experiencing problems with third-party certificates

The iPrint Appliance handles third-party certificates well when working with secure web tools and
authentications from the iPrint Mobile App. However, some third-party certificates can be
problematic when registering a remote renderer; in these situations, non-secure communication
mode is convenient because certificates are not used for the remote renderer registration.

+ Domain suffix for the iPrint Appliance and the remote renderer does not match

Secure communication mode requires both the iPrint Appliance and the remote renderer to have
matching DNS domain suffixes. For example, iprintserver.company.com and
remoterenderer.cityname.company.com will cause the remote renderer registration to fail if the
secure communication mode is selected. The non-secure communication mode ignores the
DNS suffix matching requirement.

You can verify the mode of the renderer in the Renderers page under the Secure Mode column.

+ [f the Secure Mode column displays false, then the renderer is in a non-secure communication
mode.

+ |f the Secure Mode column displays true, then the renderer is in a secure communication mode.

Automatic Printer Driver Updates

The local and remote renderer supports the Automatic Driver Update feature. When a printer driver is
updated on the Drive Store, or if the association of a particular printer agent is changed, the driver is
automatically updated on the renderer.

Local Renderer: The driver update and driver association changes takes effect when the first print
job is rendered by the old driver and the subsequent jobs are rendered by the new driver.

Remote Renderer: All the jobs submitted for printing is rendered by the driver that is currently
associated with the printer. However, the first print job that is sent for printing after the driver
association change may take some time to be rendered depending on the size of the driver. This is
because the remote renderer installs the driver first and then processes it for rendering.

Printer Rename and Redirection (Remote Renderer)

If a printer is renamed or redirected through the Management Console, the remote renderer
automatically updates its configuration to associate the correct printer drivers with the printer.

When you redirect a printer, the printer driver associated with the destination printer is used for
rendering.
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7.3 Installing and Configuring a Remote Renderer

For desktop quality printing for Microsoft Office and PDF documents, you must install a remote
renderer on a Microsoft Windows 7, Windows 8.1, Windows 2008 R2, Windows 2012, or Windows
2012 R2 64-bit system with a dual-core processor or higher.

During the remote renderer configuration process, when prompted for service configuration
credentials, local users must specify the credentials of an account with Windows admin and domain
users must specify the user name in [domainname] \ [username] format.

*

*

Section 7.3.1, “Prerequisites,” on page 66

Section 7.3.2, “Assigning Log On as a Service Rights,” on page 66

Section 7.3.3, “Downloading the Remote Renderer,” on page 67

Section 7.3.4, “Installing and Configuring the Remote Renderer,” on page 67
Section 7.3.5, “Registering the Remote Renderer,” on page 68

Section 7.3.6, “Secure Communication Mode,” on page 68

Section 7.3.7, “Non-secure Communication Mode,” on page 69

Prerequisites

Before installing and configuring the remote renderer, ensure that you have met the requirements
listed in Section 3.3, “Remote Renderer Requirements,” on page 25 and the following prerequisites:

*

At least one printer driver is uploaded to the Driver Store for the Windows platform on which you
are setting up the renderer. This is required because when you add a remote renderer from the
Management Console, you must designate one driver as the default driver for the renderer.

NOTE: It is recommended that you upload a universal printer driver such as HPUPD, and set
that as the default driver.

You must assign Log on as a service rights to the account with which you want to set up the
renderer.

7.3.2 Assigning Log On as a Service Rights

66

Before configuring the remote renderer, you must assign the Log on as a service rights to the account
with which you want to set up the renderer, on the local machine.

1

On your Windows computer, Go to Start > Control Panel.

2 In the upper-right corner of the Control Panel window, click the View by drop-down menu, then

© 00 N o 0o~ W

select Large icons.

Go to Administrative Tools > Local Security Policy.

In the left pane, double-click Local Policies.

Click User Rights Assignment.

In the right pane, under Policy, double-click Log on as a service.

Click Add User or Group.

Specify the user name in the Enter the object names to select box, then click Check Names.
Click OK after the user is displayed.
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10 Click OK.
11 Click OK, then close the Local Security Policy window.

7.3.3 Downloading the Remote Renderer

1 On a web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify root or vaadmin as the user name.

3 Specify the password that you provided for root or vaadmin.
The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

5 Under Configuration, click Renderers.

6 Click the gicon in the upper-right corner of the screen.

Renderers Configuration @DQ

NOTE: The remote renderer installation interface is not available in Slovak, Hungarian,
Netherlands Dutch, or Catalan languages

A zip file named iprintRendererBundle. zip iS downloaded. This zip file contains a setup. exe file,
iPrintRendererSetup.msi file, readme.txt, and a device.pfx certificate file.

Continue with installing and configuring the remote renderer.

7.3.4 Installing and Configuring the Remote Renderer

1 Unzip the iPrintRendererBundle. zip file, then launch the setup.exe file. Follow the on-
screen prompts to complete the installation procedure.

2 When the installation is complete, launch the command prompt in the Run as administrator
mode.

3 Run the command iPrntRendCmd -c to configure the remote renderer.

3a If you want to configure the remote renderer over a secure channel and if you are using a
self-signed digital certificate, copy the device.pfx file into the
C:\NDPS\Renderer\certificates\ folder.

3b If you want to configure the remote renderer over a secure channel and if you are using a
third-party certificate, copy the pxcsiz2 file of type .pfx or .p12 into the
C:\NDPS\Renderer\certificates\ folder.
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7.3.5

7.3.6

4 When prompted for Do you want to configure the remote renderer over secure channel,
depending on your requirement, specify Yes or No.

4a When you specify Yes, the renderer is configured in a secure mode. You need to perform
additional steps, if you need iPrint Appliance to accept only secure communications. For
more information, see Section 7.3.6, “Secure Communication Mode,” on page 68.

4b When you specify No, the renderer is configured in a non-secure mode. You need to
perform additional steps to ensure that iPrint Appliance accepts non-secure
communications. For more information, see Section 7.3.7, “Non-secure Communication
Mode,” on page 69.

5 When prompted for credentials, specify your credentials.

On successful configuration, you must register the Remote Renderer.

Registering the Remote Renderer

On the Management Console, click iPrint Appliance Configuration.
Under Configuration, click Renderers.
Click New.

In the Renderer Host/IP address box, specify the hostname or IP address of the renderer
system, then click Connect.
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Under Options, specify a name for the renderer in the Renderer Name box.

6 Select the document formats you want the remote renderer to render.

7 Choose the Default Printer Driver, then click Register.
After you click the Register button, a success message is displayed, but the remote renderer is still
configuring. The configuration time depends on the number of unique drivers associated with mobile
enabled printers. During that period, the renderer is in the Configuring state. After the configuration is
complete, the renderer changes to the Active state. When the status of the remote renderer displays

Active, it means that the registration is successful. Refresh the page after a couple of minutes to
check the status.

Secure Communication Mode

By default, the iPrint Appliance accepts both secure and non-secure communication.To set only
secure communication mode, you must ensure that the renderer is secure and the iPrint Appliance
accepts only secure communications.

On the Windows computer, run the iPrntRendCmd -c command to configure secure remote renderer.
On configuring the renderer to a secure mode, you can verify the status in the Management Console,
Renderers page under the Secure Mode column, the value displayed is true.

To configure iPrint Appliance to accept only secure communications, modify the secure
communication settings in the Management Console as follows:

1 On a web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the root or vaadmin name that you provided as the user name.

3 Specify the password that you provided for the root or vaadmin.
The Management Console page is displayed.

4 Click iPrint Appliance Configuration.
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1.3.7

5 Under Configuration, click Renderers. All the available renderers are displayed.
6 Click the Secure settings for renderers icon.
The Secure Communication Settings window is displayed.

Renderers Configuration

Hew

MName Version Address State Secure Mode Supported Formats

20006  182.968.123 Active Yes e, SO0, S0CK, S0, P, PR, PR, BRUM, P, 1, 18, xisb, s, e

7 Select the Use Secure Mode Only check box, then click OK. The iPrint Appliance will now accept
only secure communications. The non-secure renderers will fail to communicate with the iPrint
Appliance and no jobs can be rendered by those renderers.

Non-secure Communication Mode

By default, the iPrint Appliance accepts both secure and non-secure communication but if the iPrint
Appliance is modified to accept only secure communications, then you must modify the iPrint
Appliance to accept both secure and non-secure communications.

On the Windows computer, run the iPrntRendCmd -c command to configure the non-secure remote
renderer. On configuring the renderer to a non-secure mode, you can verify the status in the
Management Console, Renderers page under the Secure Mode column, the value displayed is false.

Modify the secure communication settings in the Management Console for iPrint Appliance to accept
both secure and non-secure communications:

1 On a web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the root or vaadmin name that you provided as the user name.
3 Specify the password that you provided for the root or vaadmin.
The Management Console page is displayed.
4 Click iPrint Appliance Configuration.
5 Under Configuration, click Renderers. All the available renderers are displayed.
6 Click the Secure settings for renderers icon.
The Secure Communication Settings window is displayed.
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Renderers Configuration @

Hew Rrtrst

Version Address State Secure Mode Supported Formats

20006 192168123 Sem, doca, Gotm, pal, PR, gE, EUM, PR, (1, 8, xisb, s, KK

SECTings between the remote
s setting is applicable to the

7 Deselect the Use Secure Mode Only check box, then click OK. The iPrint Appliance will now
accept both secure and non-secure communications.

7.4 Upgrading the Remote Renderer

If you have upgraded your iPrint Appliance, you must also upgrade the remote renderer. Before
upgrading the remote renderer, ensure that you have applied the patch and updated the iPrint
Appliance server.

NOTE: Upgrading the remote renderer from iPrint Appliance 1.0 or 1.0.1 to iPrint Appliance 1.1 is not
supported.

74.1 Upgrading from 1.1to 1.1 Patch 1 or later

On upgrading the iPrint Appliance from 1.1 to 1.1 Patch 1 or later, ensure to upgrade the remote
renderer as follows:

1 Follow the steps from Section 7.3.3, “Downloading the Remote Renderer,” on page 67 to
Section 7.3.4, “Installing and Configuring the Remote Renderer,” on page 67.

When the procedure is complete, the iPrint remote renderer is updated and is ready to be used.

7.4.2 Upgrading from 1.0 or 1.0.1to 1.1 Patch 1 or later

On upgrading the iPrint Appliance from 1.0 or 1.0.1 to 1.1 Patch 1 or later, ensure to upgrade the
remote renderer as follows:

1 Follow the steps from Section 7.3.3, “Downloading the Remote Renderer,” on page 67 to
Section 7.3.5, “Registering the Remote Renderer,” on page 68.

When the procedure is complete, the iPrint remote renderer is updated and is ready to be used.

7.5 Managing the Remote Renderer

You can manage the remote renderer through the Management Console.

1 On a web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify root or vaadmin as the user name.
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7.5.1

7.5.2

7.5.3

754

3 Specify the password that you provided for root or vaadmin.
The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

5 Under Configuration, click Renderers.

On the Renderers page, you can perform the following actions:

¢ Section 7.5.1, “Add a Renderer,” on page 71

+ Section 7.5.2, “Edit a Renderer,” on page 71

¢ Section 7.5.3, “Delete a Renderer,” on page 71

+ Section 7.5.4, “Activate or Deactivate a Renderer,” on page 71

Add a Renderer

1 On the Renderers page, click New.

2 In the Renderer Host/IP address box, specify the host name or IP address of the renderer
system, then click Connect.

3 Under Options, specify a name for the renderer in the Renderer Name box.
4 Select the document formats you want the remote renderer to render.

NOTE: The PDF Formats option along with the In-built PDF renderer is selected by default. If
you want to use Adobe Acrobat, you must ensure that Adobe Acrobat Pro is installed on the
renderer machine before selecting the Adobe Acrobat option. Similarly, if you want to enable the
remote renderer to render Microsoft Office formats, you must ensure that Microsoft Office is
installed on the renderer machine before selecting the Office Formats option.

5 Choose the Default Printer Driver, then click Register.

Edit a Renderer

You can change a remote renderer’s name, the document rendering options, and the default printer
driver using the Edit feature on the Renderers page.

1 On the Renderers page, select a renderer which you want to edit, then click Edit.
2 Change the rendering options, then click Commit.

Delete a Renderer

1 On the Renderers page, select a renderer that you want to delete, then click Delete.

Deleting a renderer unregisters the renderer from iPrint Appliance.

Activate or Deactivate a Renderer

1 On the Renderers page, select a renderer that you want to activate or deactivate, then click
Activate/De-Activate.

If the renderer is in an Active state, it is deactivated. If the renderer is in an Inactive state, it is
activated.

If the renderer is in an Inactive state, it will not render any job.
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1.6

Deactivating a renderer does not unregister the renderer from iPrint Appliance.

Remote Renderer Commands

The management of remote renderer is supported from the Management Console. You can
additionally use the command line interface by launching the command prompt in the Run as
administrator mode and executing the i PrntRendCmd command for the following operations:

Command Description

-h | --help Shows the various available commands with their syntax.

-v | --version Shows the current version of the remote renderer.

-c|-- Configures the remote renderer service for the specified user. It also provides the option of

configureservice

—ul -
unregisterrenderer
<iPrint Appliance
server Fully
Qualified Domain
Name or IP
address>

-rt | -
reregisterrenderer
<iPrint Appliance
server Fully
Qualified Domain
Name or IP
address>

-s |-
rendererstatus

-1 -
launchrenderer

-g |--stoprenderer

_tl -
testconverttops
<input file
location> <output
file location>

-1s | --listservers

choosing between secure and non-secure communication mode with the iPrint Appliance.

Unregisters the remote renderer from the iPrint Appliance server. Afterward, the remote
renderer stops accepting jobs from the iPrint Appliance server for conversion. The iPrint
Rendering service is running, but does not receive rendering jobs from the iPrint Appliance
server.

Installs both self-signed and unsigned drivers for remote renderers.

Displays the status of the iPrint Windows Rendering service.

Starts the iPrint Windows Rendering service. After registration, the rendering service starts
automatically.

Stops the iPrint Windows Rendering service.

Tests the conversion locally.

Lists the iPrint Appliance registered with the remote renderer.
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8.1

Managing iPrint Appliance

The Micro Focus iPrint Appliance Management Console allows you to administer iPrint Appliance,
and to change configuration settings, such as administrative passwords, network settings, and
certificate settings.

To access the Appliance System Configuration page:
1 On a Web browser, specify either the host name or the IP address. For example, https://
10.0.0.1:9443 or https://iprint.example.com:9443.
2 Specify the Username and Password, then click Log in.

The Micro Focus Appliance Configuration pane displays the following options:

+ Section 8.1, “Ganglia Monitoring,” on page 73

+ Section 8.2, “Network,” on page 74

¢ Section 8.3, “Time,” on page 74

+ Section 8.4, “Digital Certificates,” on page 75

+ Section 8.5, “Storage,” on page 83

+ Section 8.6, “System Services,” on page 84

¢ Section 8.7, “Firewall,” on page 85

+ Section 8.8, “/var Mount Configuration,” on page 85

+ Section 8.9, “Administrative Passwords,” on page 85

+ Section 8.10, “Field Patch,” on page 86

¢ Section 8.11, “Ganglia Configuration,” on page 86

+ Section 8.12, “Support,” on page 87

+ Section 8.13, “Shutting Down and Restarting iPrint Appliance,” on page 87
+ Section 8.14, “Signing Out of iPrint Appliance,” on page 87

Ganglia Monitoring

Ganglia is a scalable, distributed monitoring system that allows you to gather important information

about your iPrint Appliance system.The default metrics that you can monitor are processor, disk, load,

memory, network, and process.

To monitor iPrint Appliance using Ganglia, you must enable Ganglia Configuration in the Appliance
System Configuration page of the iPrint Appliance Management Console. For information in how to
enable Ganglia Configuration, see Section 8.11, “Ganglia Configuration,” on page 86.

To view Ganglia monitoring of your iPrint Appliance system:

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Ganglia Monitoring icon.
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An overview of all the nodes in the cluster, including information such as processor utilization,
memory, load, and so forth is displayed.

3 In the Grid-Node drop-down list, select a node that you want to monitor.
or
Scroll to the bottom of the page and click a node to get server information for your iPrint
Appliance.

For information about how to configure Ganglia for your environment, including changing from
multicast mode to unicast mode, see Section 8.11, “Ganglia Configuration,” on page 86.

8.2 Network

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Network.

3 In the DNS Configuration section, you can modify the name servers, search domains, and
gateway settings for your Micro Focus iPrint Appliance network.

If the Search Domains field is left blank, it is auto-populated with the domain of the appliance
hostname. For example, if the hostname of the appliance is iprint.mycompany.com, the
domain is auto-populated with mycompany . com.

4 In the NIC Configuration section, you can modify the IP address, hostname, and network mask
of any Network Interface Controller (NIC) associated with the appliance. (If you configured
multiple NICs for the Micro Focus iPrint Appliance, you can configure the additional NICs.)

4a In the NIC Configuration section, click the ID of the NIC.
4b Edit the IP address, hostname, or network mask.

If you change the IP address, you must restart the appliance in order for the change to be
reflected

4c Click OK.

5 (Optional) In the Appliance Configuration Ul (port 9443) Access Restrictions section, specify the
IP address of any networks for which you want to allow access to the iPrint Appliance. Leave this
section blank to allow any network to access the iPrint Appliance.

IMPORTANT: Post iPrint Appliance configuration, do not change any Network settings.

6 Click OK.

8.3 Time

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Time.

3 Change the time configuration options as necessary:
NTP Server: Specify the NTP server that you want to use for time synchronization.
Region: Select the region where your Micro Focus Appliance is located.
Time Zone: Select the time zone where your Micro Focus Appliance is located.

4 Click OK.
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8.4 Digital Certificates

The Micro Focus iPrint Appliance ships with a self-signed digital certificate. All the inbound and
outbound communications to the iPrint Appliance are via self-signed certificate. The validity of the
certificate is two years. To verify the details of self-signed certificate, see Section 8.4.1, “Viewing
Details of the Certificates,” on page 75.

To renew the self-signed certificate on expiry, see Section 8.4.3, “Self-Signed Certificate Expiry,” on
page 76.

If you want to use a third party certificate instead of the self-signed certificate, see Section 8.4.2,
“Third Party Certificates,” on page 76.

The certificate works for both the Micro Focus iPrint Appliance and the iPrint remote renderer (ports
9443 and 8443). You do not need to update your certificate when you update the iPrint Appliance
software.

Terminology

Server Certificate: This is a certificate that is used for all secure communications with iPrint
Appliance. You can either use the self-signed certificate or third party certificate.

+ Self-signed Certificate: This is the default certificate (self-signed_cert) that is shipped with
iPrint Appliance.

+ Third Party Certificate: Instead of using the self-signed certificate, you could use other trusted
server certificate that is signed by a trusted certificate authority (CA) such as VeriSign or Equifax.

Private Key: This key was generated when creating Certificate Signing Request (CSR).
Chain Certificate: This is the file from the vendor (CA). Ensure all the chain certificates are available.

+ Section 8.4.1, “Viewing Details of the Certificates,” on page 75

+ Section 8.4.2, “Third Party Certificates,” on page 76

+ Section 8.4.3, “Self-Signed Certificate Expiry,” on page 76

+ Section 8.4.4, “Creating a New Certificate and Getting it Signed,” on page 77
+ Section 8.4.5, “Activating the Certificate,” on page 78

+ Section 8.4.6, “Managing Certificates,” on page 78

+ Section 8.4.7, “Converting Certificates to pfx or p12 Formats,” on page 79

+ Section 8.4.8, “Configuring Certificates for Apache,” on page 79

+ Section 8.4.9, “Generating Certificates for Server and Remote Renderer,” on page 80
+ Section 8.4.10, “Renewing eDirectory Certificates,” on page 81

+ Section 8.4.11, “Reconfiguring Certificates,” on page 81

+ Section 8.4.12, “Troubleshooting Certificate Issues,” on page 81

8.4.1 Viewing Details of the Certificates

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Digital Certificates.
3 In the Key Store drop-down list, select JVM Certificates or Web Application Certificates.
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List of certificates are displayed that are configured on the appliance.

4 Select a certificate, then click View Info. Details of certificate such as name of the CA, validity of
the certificates will be displayed.

For example, to view details of self-signed certificate, select Web Application Certificates > self-
signed_cert, then click View Info.

8.4.2 Third Party Certificates

If you plan to use a third party certificate instead of the self-signed certificate, you need to meet the
following prerequisites:

+ Server certificate signed by CA

+ Private key

+ Chain certificates

+ All the above certificates must be packaged in a PKCS12 format
When you use an existing certificate and key pair, use a pkcs12 key pair format. If your trusted

certificates are not in PKCS12 format, see Section 8.4.7, “Converting Certificates to pfx or p12
Formats,” on page 79.

1 Go to the Digital Certificates page by clicking Digital Certificates from the Micro Focus Appliance
Configuration.

2 On the Digital Certificates page, in the Key Store drop-down menu, select Web Application
Certificates.

3 Click File > Import > Trusted Certificate. Browse and select your existing certificate, then click
OK.

3a Alias Specify a name that you want to use to identify and manage this certificate.

4 Click File > Import > Trusted Certificate. Browse and select your existing certificate chain for the
certificate that you selected in the preceding step, then click OK.

5 Click File > Import > Key Pair, then browse to and select your .p12 or .pfx key pair file, specify
your password if needed, then click OK.

6 Continue with Section 8.4.5, “Activating the Certificate,” on page 78.

8.4.3 Self-Signed Certificate Expiry

76

The self-signed certificate is valid for two years. To regenerate the self-signed certificate after expiry,
do the following:

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click Digital Certificates.
3 In the Key Store drop-down list, ensure that Web Application Certificates is selected.
4 Click File > New Certificate (Key Pair), then specify the following information:
Alias: Specify a name that you want to use to identify and manage this certificate.
Validity (days): Specify how long you want the certificate to remain valid.
Key Algorithm: Select either RSA or DSA.
Key Size: Select the desired key size.
Signature Algorithm: Select the desired signature algorithm.
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Common Name (CN): This must match the server name in the URL in order for browsers to
accept the certificate for SSL communication.

Organizational Unit (OU): (Optional) Small organization name, such as a department or
division. For example, Purchasing.

Organization (O): (Optional) Large organization name. For example, Micro Focus, Inc.
City or Locality (L): (Optional) City name. For example, Provo.
State or Province (ST): (Optional) State or province name. For example, Utah.
Two-letter Country Code (C): (Optional) Two-letter country code. For example, US
5 Click OK to create the certificate.
After the certificate is created, it is self-signed.
6 You must now activate the certificate, see Section 8.4.5, “Activating the Certificate,” on page 78.

8.4.4 Creating a New Certificate and Getting it Signed

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Digital Certificates.
3 In the Key Store drop-down list, ensure that Web Application Certificates is selected.
4 Click File > New Certificate (Key Pair), then specify the following information:
Alias: Specify a name that you want to use to identify and manage this certificate.
Validity (days): Specify how long you want the certificate to remain valid.
Key Algorithm: Select either RSA or DSA.
Key Size: Select the desired key size.
Signature Algorithm: Select the desired signature algorithm.

Common Name (CN): This must match the server name in the URL in order for browsers to
accept the certificate for SSL communication.

Organizational Unit (OU): (Optional) Small organization name, such as a department or
division. For example, Purchasing.

Organization (O): (Optional) Large organization name. For example, Micro Focus, Inc.
City or Locality (L): (Optional) City name. For example, Provo.
State or Province (ST): (Optional) State or province name. For example, Utah.
Two-letter Country Code (C): (Optional) Two-letter country code. For example, US

5 Click OK to create the certificate.
After the certificate is created, it is self-signed.

6 Select the certificate that you created in the preceding step, then click File > Certificate Requests
> Generate CSR.

7 Mail the digital certificate to a certificate authority (CA), such as VeriSign or Equifax.

The CA takes the Certificate Signing Request (CSR) and generates an official certificate based
on the information in the CSR. The CA then mails the new certificate and chain certificates back
to you.

Managing iPrint Appliance 77



78

8 After you have received the official certificate and certificate chain from the CA:

8a
8b

8c
8d

Click Digital Certificates.

Click File > Import > Trusted Certificate. Browse to the trusted certificate chain that you
received from the CA, then click OK.

Select the self-signed certificate, then click File > Certification Request > Import CA Reply.
Browse to and upload the official certificate to be used.

On the Digital Certificates page, the name in the Issuer column for your certificate changes
to the name of the CA that stamped your certificate.

9 Activate the certificate, as described in Section 8.4.5, “Activating the Certificate,” on page 78.

8.45 Activating the Certificate

1 On the Digital Certificates page, in the Key Store drop-down menu, select Web Application
Certificates.

8.4.6

2 Select the certificate that you want to make active, click Set as Active, then click Yes.

3 Verify that the certificate and the certificate chain were created correctly by selecting the
certificate, then clicking View Info.

When you activate a certificate, the Set as Active button might still be enabled for that certificate.
You can ignore it, as it does not affect the certificate activation.

Managing Certificates

All certificates that are included with the IBM Java package that is bundled with the version of SLES
that iPrint Appliance ships with, are installed when you install iPrint Appliance.

You can use the Digital Certificates tool on the iPrint Appliance to remove certificates that are not
used by your organization, if you are concerned about keeping them.

Also, you can use the Digital Certificates tool on the iPrint Appliance to maintain the certificate store
by removing certificates that have expired and then installing new certificates as needed, according to
your organization’s security policies.

To access the Digital Certificates tool:

1 Click Digital Certificates in the Micro Focus Appliance Configuration page.

To delete a certificate:

1 On the Digital Certificates page, in the Key Store drop-down menu, select Web Application
Certificates or JVM Certificates.

In Web Application Certificates, do not delete the self-signed certificate if you are using it.

In JVM Certificates, do not delete the edir_root_ca certificate. This certificate is used when
importing the users to the appliance using the Import Users feature of the appliance.

2 Select a certificate, then click Edit > Delete.

Micro Focus iPrint Appliance 2 Administration Guide



8.4.7

8.4.8

Converting Certificates to pfx or p12 Formats

The iPrint Appliance server only accepts certificates that are in .pfx or .p12 format. Use this script to
convert the third-party certificate to .pfx or .p12 format. The location of the certman.sh is /opt/
novell/iprintmobile/bin.

On successful conversion, you can upload the certificates to the iPrint Appliance server.
Syntax: Execute the following script on the appliance server:

sh certman.sh -t convert <options>

Table 8-1 Certificate Conversion Options

Parameter Description

-h Displays help

-i <format> Specify the input certificate format. Valid formats: crt, pem, or cer.

-0 <format> Specify the format to convert the certificate. Valid formats: pfx or p12

-w <absolute path> Specify the path to create the output (pfx or p12) file.

-c <absolute path> Specify the path to the input certificate file. Valid formats: crt, .cer, or .pem

-k <absolute path> Specify the path to the key file.

-n <absolute path> Specify the path to the chain certificate file.

-p <key passphrase> (Optional) Specify the passphrase for the key file. The default value is ‘changeit'

when no value is specified.

Examples: The server certificate is vaserver.crt, the key file vaserver.key, and the chain
certificate is chain certificate.pem. On successful conversion the certificates are converted to
pfx format.

sh certman.sh -t convert -i crt -o pfx -c¢ /vastorage/conf/certs/vaserver.crt -k /
vastorage/conf/certs/vaserver.key -n /vastorage/conf/certs/chain certificate.pem -
w /tmp/cert.pfx

Configuring Certificates for Apache

Use this script to configure the certificates for the Apache server.
Syntax: Execute the following script on the appliance server:

sh certman.sh -t apache <options>

Table 8-2 Apache Configuration Options

Parameter Description
-h Displays help.
-a Configures Apache automatically with the default path of the certificate file and key

file. Only the passphrase option (-p) can be used with this option.

-r <path> Specify the absolute path of the certificate file.
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Parameter Description

-k <path> Specify the absolute path of the key file.

-n <path> Specify the absolute path of the certificate chain file.

-c <path> Specify the absolute path of the CA certificate file.

-p <key passphrase> (Optional) Specify the passphrase for the key file. The default value is 'changeit'

when no value is specified.

Example 1: If you are facing issues when using a self-signed certificate, use the -a option to
configure Apache automatically.

sh certman.sh -t apache -a
Example 2: To configure the third-party certificates for the Apache server, execute the following:

sh certman.sh -t apache -r /vastorage/conf/certs/vaserver.crt -k /vastorage/conf/
certs/vaserver.key -n /vastorage/conf/certs/chain certificate.pem -c /vastorage/
conf/certs/CA certificate.pem

8.49 Generating Certificates for Server and Remote Renderer

Use this script to regenerate the certificates of the iPrint Appliance server and the Remote renderer
client.

Syntax: Execute the following script on the appliance server:

sh certman.sh -t cert <optionss>

Table 8-3 Certificate Generation Options

Parameter Description

-h Displays help.

-S Generates the certificate for the server.

-g Generates the certificate for the remote renderer client.

-d <directory> (Optional) Specify the directory to store the newly created certificates.

-i Imports certificates to the Java keystore.

-k <keystore> (Optional) Specify the path to the Java keystore. If no path is provided the
certificates are imported to the default path /vastorage/conf/certs/
keystore.

Example 1: If the self-signed certificate is expired, execute the following script:

sh certman.sh -t cert -s -i

This regenerates the certificates and configures the server.

Example 2: If the remote renderer certificate is expired, execute the following script:

sh certman.sh -t cert -g
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8.4.10

8.4.11

8.4.12

This regenerates the certificates and will be placed in a bundle with the remote renderer. You can now
download these newly generated certificates from the Renderers page in the Management Console.

Renewing eDirectory Certificates

Use this script to renew the eDirectory certificates.
Syntax: Execute the following script on the appliance server:

sh certman.sh -t edir <options>

Table 8-4 eDirectory Regeneration Options

Parameter Description
-h Displays help
-r Regenerates the certificates for eDirectory.

Reconfiguring Certificates

If you are facing any issues with the certificates, use this script to reconfigure the certificates for the
appliance.

Syntax: Execute the following script on the appliance server:

sh certman.sh -t repair <options>

Table 8-5 Certificate Repair Options

Parameter Description
-h Displays help.
-a Performs repair of the certificates automatically. This also creates a

backup of the previous certificate configuration.

-r Reverts to the state of the certificate before the execution of the -a option.

Example: If you are facing issues with the self-signed or third party certificates, execute the following:
sh certman.sh -t repair -a

This will repair the certificates and reconfigure the appliance.

Troubleshooting Certificate Issues

+ Authentication Failure When Logging to the Mobile Apps
+ Logging to the Management Console Displays an Untrusted Certificate Message (page 82)
+ OES Signed Certificate
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Authentication Failure When Logging to the Mobile Apps

Logging to the Mobile App fails with an authentication error.

One of the reason for this failure could be the missing trusted CA certificate. To verify if it is a
certificate issue, view the details of certificate. To resolve the issue, perform the following:

1 Convert the third party certificates to a p12 format. For more information, see Section 8.4.7,
“Converting Certificates to pfx or p12 Formats,” on page 79
2 Import the p12 format certificates to the iPrint Appliance.

2a Go to the Digital Certificates page by clicking Digital Certificates from the Micro Focus
Appliance Configuration.

2b On the Digital Certificates page, in the Key Store drop-down menu, select Web Application
Certificates.

2c Click File > Import > Trusted Certificate. Browse and select your existing certificate, then
click OK.

2d Click File > Import > Trusted Certificate. Browse and select your existing certificate chain for
the certificate that you selected in the preceding step, then click OK.

2e Click File > Import > Key Pair, then browse to and select your .P12 key pair file, specify your
password if needed, then click OK.

2f Select the certificate that you want to make active, click Set as Active, then click Yes.

2g Verify that the certificate and the certificate chain were created correctly by selecting the
certificate, then clicking View Info.

3 Restart the services: apache, jetty, and mobile server.

Logging to the Management Console Displays an Untrusted
Certificate Message
Logging to the Management Console or Mobile Apps displays an untrusted certificate message. This

is caused when chain certificates are missing from the p12 file. Due to missing chain certificates,
iPrint Appliance is not able to validate the certificates from the CA.

To resolve this issue, when using third party certificates, ensure to include chain certificates to the
root CA.

OES Signed Certificate

If you have used OES as a certificate authority (CA) to sign the iPrint Appliance certificate, then all the
logins to Apps and browsers will display an untrusted certificate error. To resolve this issue, perform
the following:

1 Download the OES CA certificate in DER format from the OES server.

2 Convert the DER format certificate to PEM format using the following script:

openssl x509 -inform der -in <OES CA certificate>.der -out
<OES CA certificate>.pem

3 Copy the OES CA certificate.pemfile to /vastorage/conf/certs folder

4 Inthe /etc/apache2/vhosts.d/vhost-ssl.conf file, edit the path of the parameter
SSLCACertificateFile with the newly created OES CA certificate.

Micro Focus iPrint Appliance 2 Administration Guide



Certificate Authority (CR):
Set the CA certificate wverification path where to find CA&
certificates for client authentication or alternatively one
huge file containing all of them (file mu=st be PEM encoded)
Note: Inside S5LCACertificatePath you need hash symlinks
to point to the certificate files. Use the provided
Makefile to update the hash symlinks after changes.
fS8LCcACertificatePath /fetc/apache2/=ssl.crt
lSSLCACertificateFile /vastorage/conf/certs/0ES CA certificate.pem

H o o

5 Using the following script, combine the certificate files vaserver.key, vaserver.crt, and the OES
CA certificate (OES_CA certificate.pem)to a pfx format.

sh certman.sh -t convert -c <absolute path server certificate> -k
<absolute path key> -n <absolute path chain certificate> -w <options>

sh certman.sh -t convert -i crt -o pfx -c¢ /vastorage/conf/certs/vaserver.crt -
k /vastorage/conf/certs/vaserver.key -n /vastorage/conf/certs/
OES CA certificate.pem -w /temp/cert.pfx

6 Go to the Digital Certificates page by clicking Digital Certificates from the Micro Focus Appliance
Configuration.

7 On the Digital Certificates page, in the Key Store drop-down menu, select Web Application
Certificates.

8 Click File > Import > Key Pair, then browse to and select your .p12 or .pfx key pair file, specify
your password if needed, then click OK.

9 Activate the certificate.

8.0 Storage

If you have created partitions for /vastorage and /var, iPrint Appliance provides native tools to allow
you to expand the storage space for the /vastorage and /var partitions.

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click Storage.

3 Use the tools provided by your virtualization platform vendor to expand the virtual disks that
contain the partitions your are expanding.

4 In the provided table, select the partitions to be expanded.
5 Click Expand partitions.

Appliance services are stopped, the selected partitions are expanded to the size of their
respective disks, and appliance services are restarted.

6 Reboot the appliance so the operating system can detect the disks that have been expanded.
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8.6

8.6.1

8.6.2

8.6.3

System Services

This section displays the system services that are required for iPrint Appliance.

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click System Services.

3 You can perform the following actions:

+ Section 8.6.1, “Starting, Stopping, or Restarting System Services,” on page 84
+ Section 8.6.2, “Setting System Services to Automatic or Manual,” on page 84

+ Section 8.6.3, “Downloading Log Files for System Services,” on page 84

Starting, Stopping, or Restarting System Services

1 Select the service that you want to start, stop, or restart.
2 Click Action, then click Start, Stop, or Restart.
3 Click Close to exit System Services.

Setting System Services to Automatic or Manual

1 Select the service that you want to make automatic or manual.
2 Click Action, then click Set as Automatic, or Set as Manual.

Downloading Log Files for System Services

In the Log Files column of the table, click the download link for the service for which you want to view
log files.

You can download the following log files for each service:
SSH: This is the SSH service that is running on the appliance.

Micro Focus iPrint Mobile: The iprintmobile0.log file includes log messages related to mobile server
and renderer. To access this file, either click Download or browse to /var/opt/novell/log/
iprintmobile/ folder.

Micro Focus iManager: The catalina.out file includes log messages related to iManager
operations. To access this file, either click Download or browse to /var/opt/novell/tomcaté6/logs/
folder.

Authentication Services: The catalina.out file includes log messages related to services
accessed by the users. To access this file, either click Download or browse to /opt/novell/filr/
apache-tomcat/logs/ folder.

NetlQ eDirectory: The ndsd. 1og file includes log messages related to eDirectory operations. To
access this file, either click Download or browse to /var/opt/novell/eDirectory/log/ folder.

Apache server for Micro Focus iPrint: The error log file includes log messages related to
Apache web server operations. To access this file, either click Download or browse to /var/log/
apache2/ folder.
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8.7

8.8

8.9

Avahi: The messages file includes log messages related to Appliance system operations. To access
this file, either click Download or browse to /var/log/ folder.

Driver Store: The idsd. log file includes log messages related to driver store operations. To access
this file, either click Download or browse to/var/opt/novell/log/iprint/ folder.

Print Manager: The ipsmd. log file includes log messages related to print manager operations. To
access this file, either click Download or browse to /var/opt/novell/log/iprint/ folder.

Firewall

You can view your current firewall configuration directly from the iPrint Appliance:
1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click Firewall.
Port numbers are listed with the current status of each port number. This page is for
informational purposes and is not editable.

To have seamless experience with iPrint Appliance, ensure you do not block the ports with your
firewall settings. For more information, see Section 3.2, “Ports Requirements,” on page 22.

/var Mount Configuration

iPrint Appliance system events are logged in the /var directory. Since the /var directory can fill up
with log files and cause the boot partition to grow, it is recommended that /var be located either on a
separate hard disk on the appliance, or on a remote NFS directory.

To move the /var directory to a dedicated disk or to a remote NFS directory:
1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click /var Mount Configuration.
3 Specify the hard disk information for the /var directory:
+ Select disk: Select the hard disk where you want to place /var.
+ File system type: Specify the type of file system.
4 Click OK.

Administrative Passwords

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Administrative Passwords.
3 Specify new passwords for the root and vaadmin administrators.
If you are changing the root password, you must first specify the current root password.

4 (Optional) Select or deselect Allow root access to SSH. When this option is selected, the root
user is able to SSH to the appliance. If this option is not selected, only the vaadmin user can
SSH to the appliance.

5 Click OK.
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IMPORTANT: To change the eDirectory admin password, launch the terminal and run the script
iprint edir change passwd.sh.

8.10 Field Patch

You can manage field test patches for the iPrint Appliance from the Field Patch page. You can install
new patches, view currently installed patches, and uninstall patches.

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Field Patch.

3 (Optional) Install a Downloaded Patch:

3a Before you can install a patch, you first need to download it from the Novell Support web
site (https://www.novell.com/support/) to your management workstation.

3b From the Field Test Patch page on the iPrint appliance, click Browse.
3c Browse to and select the patch that you downloaded in Step 3a.
3d Click Install.

4 (Optional) Manage Installed Patches: Uninstall Patch

4a Click Uninstall Latest Patch to uninstall the latest patch. You may not be able to uninstall
some patches.

5 (Optional) Manage Installed Patches: Download Log File

5a Click Download Log File to download the log file. This file includes details about patch
installation.

8.11 Ganglia Configuration

Ganglia is a scalable, distributed monitoring system that allows you to gather important information
about your iPrint Appliance system. The default metric that you can monitor are CPU, disk, load,
memory, network, and process.

To monitor iPrint Appliance using Ganglia, you must enable Ganglia Configuration as follows:
1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click Ganglia Configuration.
3 As necessary, change the following Ganglia configuration options:

Enable Full Monitoring Services: Select this option to receive and store metrics from other
appliances, and to allow the Ganglia Web Interface to run on the same machine as the iPrint
appliance.

You might want to disable Ganglia monitoring by deselecting this option if:
+ You already have a monitoring system that you plan to use for iPrint.

+ You plan to configure a dedicated appliance for viewing monitoring information. (You do this
by selecting Unicast below, then specifying the host name or IP address of the appliance
where monitoring information will be collected.)
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Enable monitoring on this appliance: Select this option to enable Ganglia monitoring on this
appliance.

+ Multicast: Select this option to send monitoring information to other appliances on the
network.

+ Unicast: (Recommended) Select this option to send monitoring information to a single
destination.

Unicast mode is recommended for improving performance of the iPrint system.

Publish to: Specify the URL where Ganglia sends monitoring information when it is running
in Unicast mode.

4 (Optional) Click Reset Database to remove all existing Ganglia metrics from this appliance.
This option is not related to the iPrint database.
5 Click OK.

For more information about how to use Ganglia monitoring with iPrint Appliance, see Section 8.1,
“Ganglia Monitoring,” on page 73.

8.12 Support

You can upload configuration files to Novell Support via FTP, or to download the configuration files so
that you can send them by an alternative method.

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click Support.

3 Select Automatically send the configuration to Novell using FTP to automatically send your iPrint
Appliance system’s configuration information to Novell Support via FTP.

or

Select Download and save the configuration file locally, then send it to Novell manually to
download your iPrint Appliance system’s configuration information to your management
workstation. You can then send the information to Novell Support using a method of your choice.

4 Click OK to complete the process.

8.13 Shutting Down and Restarting iPrint Appliance

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Reboot or Shutdown.

8.14 Signing Out of iPrint Appliance

1 In the upper-right corner of the Management Console page, next to the user name, click Logout.

On the Management Console page, along with the user name, Home and Logout links are
available. The Home directs you to the iPrint Appliance main page, and the Logout signs out of
the iPrint Appliance.
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9 Managing Print System

In this section, you can manage the appliance through the iPrint Appliance Management Console and
the configure the server to automatically update the Macintosh and Windows clients.

The iPrint Appliance Management Console allows you to add and manage printers, check the printer
status, create printer maps, and monitor iPrint Appliance. To access the Management Console, on a
Web browser, specify either the host name or the IP address. For example, https://
iprint.example.com:9443 or https://10.0.0.1:9443.

The iPrint Appliance Management Console page displays the following options:

+ Section 9.1, “iPrint Appliance Configuration,” on page 89

+ Section 9.2, “Appliance System Configuration,” on page 112

¢ Section 9.3, “iPrint Printer Configuration (iManager),” on page 112
+ Section 9.4, “What’s Next,” on page 153

9.1 iPrint Appliance Configuration

The iPrint Appliance Configuration page displays the following options:

+ Section 9.1.1, “Printers,” on page 89

¢ Section 9.1.2, “WalkUp Printers,” on page 92

¢ Section 9.1.3, “iPrint Release Portal for Users,” on page 95

¢ Section 9.1.4, “Manage Printers (iManager),” on page 96

+ Section 9.1.5, “Printer Status,” on page 96

+ Section 9.1.6, “Mobile,” on page 96

¢ Section 9.1.7, “Renderers,” on page 98

¢ Section 9.1.8, “Driver Store,” on page 99

+ Section 9.1.9, “AirPrint Settings,” on page 99

¢ Section 9.1.10, “Import Users,” on page 99

¢ Section 9.1.11, “Printer Map (iPrint Map Designer Tool),” on page 109
¢ Section 9.1.12, “Customizing HTML Interface for Installing Printers,” on page 110
+ Section 9.1.13, “Backup,” on page 111

¢ Section 9.1.14, “License,” on page 112

9.1.1 Printers

The Printers page lists all printers currently managed by iPrint Appliance. You can enable a printer for
AirPrint, Email printing, and IPP printing.
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Advertising a Printer as AirPrint

1 Select a printer or printers, click the AirPrint drop-down menu, then click Enable Advertising.
Currently only “HP LaserJet 500 color MFP M570dw” printer is supported for AirPrint printing.

On enabling the printer for AirPrint, the printer is advertized as an AirPrint-enabled printer and
also gets enabled for Mobile and Email Printing.

Enabling Mobile Printing for a Printer

1 Select a printer or printers, click the Mobile drop-down menu, then click Enable.

On enabling the printer for mobile, you can print to that printer from your mobile devices or by
using the email printing feature.

Enabling Private Email Printing

Using email printing, you can print documents from any device capable of sending emails. You can
print emails by specifying email printing commands in the subject line of the email. You can also print
documents by emailing them to your printer as attachments. When configured for email printing, iPrint
Appliance becomes a client to an email server.

To enable private email printing, you must ensure to meet the following:

+ Enable the printer for mobile printing
+ Configure global emalil settings
+ Email accounts are created and functional

You can configure a printer for private email printing by providing a specific email address to each
printer. To enable a private email address for the printer, do the following:

1 Select a printer, click the Configure drop-down menu, then click Private Email Settings.
2 Specify the values as follows:

Account +* Email Address: Specify the full email address of the mailbox to be polled for the
print jobs. When an email-based job arrives, the print job is processed to the
printer. For example, print@example.com.

+ Username: Specify the user name to be used by iPrint Appliance to log in to the
email server to access the private printer email account. For example, iprint.

+ Password: Specify the password for iPrint Appliance to log in to the email
server to access the private printer email account.

+ Retype Password: Confirm the account password.
Server + Incoming Mail Server: Specify the address of the incoming email server for the
email account. For example, imap.example.com.

+ Outgoing Mail Server: Specify the address of the outgoing email server for the
email account. For example, smtp.example.com.

+ Access Method: iPrint Appliance supports two different protocols to poll for
incoming print jobs. Select POP or IMAP depending on the protocol your email
server supports.
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Caveats For Email Printing

+ An email address used for a particular printer (per-printer email configuration) cannot be shared
for any other printer or mobile service.

+ |f you configure a printer for private email printing and then disable the printer for Mobile printing,
the private email configuration settings are deleted. If you want to enable private email printing in
future, you must specify the information manually.

Editing a Printer

1 To view and modify the details of a printer, click the printer name.

Printer: HP LaserJet 500 0
AirPrint™ Advertising: Disabled
Bonjour Service Nare HP LaserJet 500
Address 192.168.2 4
Geo-location:
Device Location: prova
Description: HP LaserJet 500 colorMFF
Printer Status
Manage Printer. iManager
Manage Certificates: Digital Certificates

2 You can modify the details as follows:
+ AirPrint Advertising: Click the button to enable or disable AirPrint advertising.

Currently only “HP LaserJet 500 color MFP M570dw” printer model is supported for AirPrint
printing.

+ Bonjour Service Name: Displays the name with which the printer will be advertised as
AirPrint printer.

+ Address: Displays the IP address or host name of the printer.

+ Geo-location: (Optional) Geographical location of the printer.

+ Device Location: (Optional) Local location of the printer.

+ Description: (Optional) Specific description related to the printer.

+ Printer Status: Displays the health monitoring GUI to monitor the printer status.
+ Manage Printer: Displays the iManager GUI to manage the print environment.

+ Manage Certificates: Displays the Digital Certificates page. The certificates are managed
from this location.

3 Click Save.

Printer Rename and Printer Refresh

You can rename a printer from the Printers page. Select a printer you want to rename, click the
Configure menu, then click Rename Printer.

To refresh the printers list, click the Refresh button in the upper right of the Available Printers window.
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9.1.2

Bulk Printer Creation Using a CSV File

You can create multiple printers using a csv file. You must create a csv file, then upload the csv file
into iPrint Appliance by clicking the Bulk Printer Creation button in the upper-right corner of the
Printers Configuration page.

The csv file must contain the following fields:
PrinterName, PrinterIP, Location,Description,Win95 98 Driver,Winnt Driver,Win2k Driv
er,Winxp Driver,Linux Driver,Mac Driver,Vista32 Driver,Vista64 Driver,Win732 Drive

r,Win764 Driver,Win832 Driver,Win864 Driver,Enable DirectPrinting, Secure
Printing, Enable Auditing, LPR/RAW,Raw Port

Uploading the CSV File

1 On a Web browser, specify either the host name or the IP address. For example, https://
10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the Username and Password, then click Log in.
3 Click Manager iPrint Appliance.
4 Click Printers.
5 Click the Bulk Printer Creation button in the upper-right corner of the window.
Create Printers from CSV X
| CSV File: Browse...
Download Sample C5V (0] 4 Cancel

5a To download the sample csv file, click Download Sample CSV.
6 Navigate to the .csv file, select it, then click OK to begin the printer import process.

For more information on the parameters in the csv file, see Section 5.2.3, “Bulk Printer Import Using a
CSV File,” on page 44.

WalkUp Printers

WalkUp printer is a virtual print queue that includes group of physical printers. The print jobs sent to
the WalkUp printer are put on hold by the iPrint Appliance server and released to a desirable printer.
To release the job, use a web browser and specify the server address (<https://
<Appliance_IP_address or host_name>/user) to launch the Release Portal Ul. On successful user
authentication, a list of jobs on hold are displayed.

You must associate drivers for printers when performing desktop printing.
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Figure 9-1 WalkUp Flow
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Prerequisites

+ Ensure that the physical printers are available before creating a WalkUp printer.

+ All the WalkUp jobs are stored on the secondary disk. Depending on the usage of the print
service, decide the space required on the secondary disk.

+ The users releases the jobs by using a Release Portal. Ensure that the user is aware of the
printer location and printer names.

In the Management Console, WalkUp Printers page, you can create, edit, and delete a WalkUp
printer. You can modify the job hold duration for a printer and also enable it for Mobile printing.

Creating a WalkUp Printer

1 Under Configuration, click WalkUp Printers.
2 Click New.

3 Specify the name of the WalkUp (virtual) printer. This name will be exposed to the user when
they install printers on their desktop or mobile devices.

4 (Optional) Specify description for the printer.
5 To enable mobile users to use this printer, select Enable printer for Mobile Printing.

6 From the list of printers, select the printers to group under the WalkUp printer. The jobs sent to
the WalkUp printer will be put on hold and the user will have control to release those jobs to one
of the grouped printer.

You must select at least one printer.
7 Click Next.
8 Assign platform-specific drivers for the WalkUp printer.
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If Windows drivers are selected, then bi-directional communication can be set for the WalkUp
printer.

8a Specify the IP Address or host name from the pool of the printer that you have selected for
WalkUp.

9 Click Finish.

WalkUp printer object is created that includes group of printers. The jobs on hold can only be
released to these printers.

Editing a WalkUp Printer

1 Under Configuration, click WalkUp Printers.
2 Click the printer name.
Displays the details of the printer and its drivers.
3 In the Printer Details tab, modify the details of the printer.

4 Click the Drivers tab, then reassign the drivers for the selected printers. You can also modify the
IP address or host name for bi-di communication.

5 Click Save.
The modified settings are applicable to all jobs sent to the selected WalkUp printer.

Deleting a WalkUp Printer

Ensure all the jobs are completed before deleting the printer. On deleting this printer, all the held jobs
will be automatically cancelled.

1 Under Configuration, click WalkUp Printers.

2 Select a printer or printers, then click Delete.

Enabling Mobile Printing for a WalkUp Printer

1 Under Configuration, click WalkUp Printers.
2 Select a printer or printers, click the Mobile drop-down menu, then click Enable.

Modifying the Job Hold Time

By default, the job is put on hold for four hours, after which the job will be cancelled. You can modify
the time duration to put the job on hold as follows:

1 Under Configuration, click WalkUp Printers.

2 Click Settings.

3 Modify the duration to hold a job. This change is applicable only for the jobs put on hold after the
setting is modified. The existing jobs will continue to be on hold as per the earlier set duration.
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Caveats for Implementing WalkUp Printing

This section lists a few pointers for avoiding common WalkUp implementation problems.

*

Using iManager: The following management tasks for the WalkUp printer are only managed by
iManager:

+ Enable auto driver or profile update
+ Assign driver profiles

+ Set Access Control

+ Enable auditing

+ Delete held jobs

Using iPrint status (iPrint Health Monitoring page): The following tasks of the WalkUp
printers are monitored using the iPrint Health Monitoring tool:

+ Delete held jobs
+ Enable auditing

Provide access for users: By default, only the WalkUp administrator and the user created in
the iPrintAppliance container will have access to the WalkUp printer. To provide access to all
the imported users or users in other containers use iManager.

Job hold time: By default, the job is put on hold for four hours, after which the job is cancelled. If
a job is cancelled it is no longer available in the Release Portal. The job hold time can be
modified from the Management Console. For more information, see “Modifying the Job Hold
Time” on page 94.

Insufficient balance when printing in PaperCut setup: If the user prints in spite of having
insufficient balance in his account, the job is canceled even though the Release Portal displays a
success message.

iPrint Release Portal for Users

The iPrint Release Portal displays the jobs that are put on hold, the time the job was submitted to the
WalkUp printer, and the expiry time of the job. By default, the job is put on hold for four hours, after
which the job will be cancelled. If a job is canceled it is no longer available in the Release Portal.

To launch the Release Portal in a web browser, specify the Appliance server’s address (<https://
<Appliance_IPaddress or host_name>/user> or <https://<Appliance_I|Paddress or host_name>:9443/
release-portal).

Printing a WalkUp Job

1

Using a web browser, specify the server address (https://<Appliance_IPaddress or host_name>/
user) or (https://<Appliance_IPaddress or host_name>:9443/release-portal).

Specify the user authentication details.

On successful authentication, jobs are displayed.

3 Select the document, then click Print.

Select the printer, then click OK.
The document is printed by the selected printer.
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9.1.6

Deleting a WalkUp Job

1 Using a web browser, specify the server address (https://<Appliance_IPaddress or host_name>/
user) or (https://<Appliance_IPaddress or host_name>:9443/release-portal).

2 Specify the user authentication details.
On successful authentication, jobs are displayed.

3 Select the document or multiple documents, then click Delete.
The selected jobs are deleted and no longer available to print.

Manage Printers (iManager)

This page displays the iManager interface.

Using iManager, you can manage the print environment such as create printers, printer drivers,
profiles, and users. You can also manage workstations. For more information, see Section 9.3, “iPrint
Printer Configuration (iManager),” on page 112.

Printer Status

This page displays a global view of your print system. The tool displays the current status of Printer
Agents, and lets you configure settings and generate reports about your print system.

For more information about the iPrint Printer Status tool, see the Micro Focus iPrint Appliance 2:
Micro Focus iPrint Appliance Health Monitoring Guide.

Mobile

On the Mobile configuration page, you can configure default options for mobile printing and email
printing.

Global Mobile Settings

Following are the default settings for all the printers when printing from the mobile app. When
performing print, these settings can be modified for a individual printer.

Paper Size: Select Letter or A4.
Orientation: Select between Landscape or Portrait printing.

Enable Duplex Printing: Duplex printing allows printing on both the sides of a paper. Print devices
without this capability can only print on a single side of paper (simplex printing).

Enable Color Printing: Color printing prints the documents in color, as opposed to monochrome
(black and white) printing.

Global Email Settings

iPrint Appliance can be configured to accept print jobs through email messages and attachments.
Using email printing, you can print documents from any device capable of sending emails. You can
print emails by specifying email printing commands in the subject line of the email. You can also print
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documents by emailing them to your printer as attachments. When configured for email printing, iPrint
Appliance becomes a client to an email server. Email account inbox is polled for incoming print jobs,
which are routed to the intended printer.

Ensure email accounts are created and functional prior to their association with the iPrint Appliance.

Enable email-based printing: Select this option to enable email printing. A global email address is
assigned for all the printers.

The following fields are used by iPrint Appliance to describe and access the global email account:

Email address: Specify the full email address for global print jobs. For example,
print@example.com. Ensure to use an exclusive email account for iPrint Appliance. Do not use an
existing email account.

iPrint Appliance polls the inbox of this email address looking for print jobs. When an email-based job
arrives, the subject line is parsed to determine the printer to which the job is sent.

IMPORTANT: If an existing email account is used, the mails in that account might get deleted, auto-
replied, and so on.

Account Username: Specify the user name for iPrint Appliance to log in to the email server to
access the global email account. For example, iprint.

Account Password: Specify the password for iPrint Appliance to log in to the email server to access
the global email account.

Incoming Mail Server: Specify the address of the incoming mail server for the email account. For
example, imap.example.com.

Incoming Server Type: iPrint Appliance supports POP and IMAP protocols to poll for incoming print
jobs. Select POP or IMAP depending on the protocol that your email server supports. For more
information, see Section A.1, “Incoming Mail Server Parameters,” on page 197.

Outgoing (SMTP) Mail Server: Specify the address of the outgoing mail server for the email
account. For example, smtp.example.com. iPrint Appliance uses the SMTP protocol to send email
back to users who submit email-based print jobs to report their job status. In order to support iPrint
Appliance, the email server you select must support the SMTP protocol. For more information, see
Section A.2, “Outgoing Mail Server Parameters,” on page 198.

Message body Printing: With email-based printing, attachments are always printed. This option
allows the email message body to also be printed. It is enabled by default.

Polling Interval: Configures the interval (in seconds) at which emails are fetched from the mail
servers.

IMPORTANT: When using email printing, the print command in the subject line might trigger spam
filters. To avoid this issue, configure your email system to allow print-specific emails. Include the
approved print users in the spam filter of your email system to prevent unwanted print requests.

You can also configure a printer for private email printing by providing a specific email address to
each printer. For more information, see “Enabling Private Email Printing” on page 90.
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9.1.7 Renderers

The Renderers Configuration page allows you to download the remote renderer and also manage all
the renderers. For more information about installing and configuring a remote renderer, see
Section 7.3, “Installing and Configuring a Remote Renderer,” on page 66.

On the Renderers page, you can perform the following actions:

+ “Add a Renderer” on page 98

+ “Edit a Renderer” on page 98

+ “Delete a Renderer” on page 98

+ “Activate or Deactivate a Renderer” on page 99

Add a Renderer

1 Under Configuration, click Renderers.
2 Click New.

3 In the Renderer Host/IP address box, specify the host name or IP address of the renderer
system, then click Connect.

4 Under Options, specify a name for the renderer in the Renderer Name box.
5 Select the document formats you want the remote renderer to render.

NOTE: The Build-in PDF renderer is selected by default. If you want to use Adobe Acrobat, you
must ensure that Adobe Acrobat Pro is installed on the renderer machine before selecting the
Adobe Acrobat option. Similarly, if you want to enable the remote renderer to render Microsoft
Office formats, you must ensure that Microsoft Office is installed on the renderer machine before
selecting the Office Support option.

6 Choose the Default Printer Driver, then click Register.

Edit a Renderer

You can change a remote renderer’s name, the document rendering options, and the default printer
driver using the Edit feature on the Renderers page.

1 Under Configuration, click Renderers.
2 Select a renderer which you want to edit, then click Edit.
3 Modify the details, then click Commit.

Delete a Renderer

1 Under Configuration, click Renderers.
2 Select a renderer that you want to delete, then click Delete.

Deleting a renderer unregisters the renderer from the iPrint Appliance.
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